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NOTE:  Media Maker Help File                                                        [Word Count: 21,693] 
Introduction 
 
About Media Maker 
 

Media Maker is a CD mastering software. Using Media Maker and a supported CD/DVD recorder, you can 
produce Compact Discs in various formats, including CD-ROM, CD-ROM XA, DVD-ROM, Audio CD/DVD, Video 
CD, Mixed Mode and CD Extra. The familiar Windows interface makes CD-ROM publishing as easy as dragging 
and dropping files or pointing and clicking a mouse. Simply drag and drop files from your source hard disk or 
other media to your CD layout image and in minutes you will have mastered your own CD. 

Media Maker’s intuitive user interface allows you to instantly navigate your way around your computer to locate 
files easily. Locate files using the Windows's find utility easily from the toolbar. Our all-new user interface has 
never been easier. All operations are accomplished in very simple steps. Each step is clearly identified by Media 
Maker. 

Recording most CD types is a simple two-step process.  

• Step one, layout the target disc using tools like Explorer and Find directly from the Media Maker window.  
• Step two writes the CD.  

Creating your own CDs has never been easier or faster Using Media Maker and now you can create your own 
personalized jewel case covers and CD labels with our new JewelCase Maker program. 

Media Maker offers the following advantages, making it the best and easiest solution for making your 
own CDs. 

• Takes advantage of 32-bit power of Windows and supports long file names. 
• CD Copy supports most major CD formats, including: CD-ROM, CD-ROM XA, DVD-ROM, Audio 

CD/DVD, Video CD, Mixed Mode and CD Extra. 
• Pre-masters data CD (CD-ROM, CD-ROM XA, DVD-ROM), and Audio CD/DVD. 
• File CD for convenient drag-and-drop packet-writing to BD-RE/±RW/-RAM or CD-RW media. 
• Makes Audio CD/DVD from WAV, WMA or MP3 files. 
• Drag & Drop files to create disc images. 
• Adjustable software settings make CD recording a smooth and reliable operation. 
• Read track will backup a track from a disc in the CD-Recorder to a hard disk. 
• Compile Audio CD/DVD sounds from various source CDs to a CD-R disc with a minimum hard disk 

space requirement 
• Multi-session support. 
• Session Explorer, File Compare Utility and JewelCase Maker.  
• Track-At-Once, Disc-At-Once and Session-At-Once recording. 
• User selectable inter-track gap 
• Plug-In support to enhance the power of your Media Maker software. 

In addition to the above, Media Maker offers the following features: 
• Records Audio CD/DVD’s on the fly directly from line-in and microphone, ideal for live sound recording 

such as Karaoke. 
• Premasters Video CD/Super VCD, Mixed Mode, CD Extra, and Custom CD. 
• MPEG-1 encoding converts AVI files to MPEG-1 format for Video CD mastering. 
• MPEG-2 encoding converts AVI files to MPEG-2 format for Super Video CD mastering. 
• VCD/SVCD Slide Show with and without background audio. 
• VCD/SVCD Menu 
• MP3 encoding converts CD tracks, WMA and WAV files to MP3 format. 
• WMA encoding converts CD tracks, WAV and MP3 files to WMA format. 
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• New and improved JewelCase Maker utility to design your own CD labels and jewel-case inserts. 
• Wave Editor with Trim, Normalize, Fade, Echo, Filter and Amplify functions. 
• Create a MP3 CD from any supported audio track. 
• Create a WMA CD from any supported audio track. 

 
 

 
Basic Configuration and Setup 

Welcome to Media Maker! 
Media Maker is your one stop audio, video, photo, data, backup, and utilities media resource. 

 
Close Media Maker application. 

 
Open help file. 

 
Minimize Media Maker application. 

 
Home. 

 
Disc Information Tools. 

 
Erase Disc. 

 
Drive Properties.  

 
Live Update. 

Audio 

 

• Create an Audio CD/DVD from WMA, WAV or MP3 files. 
• Create an MP3 CD from any supported audio files. 
• Edit your audio files with Audio Editor. 
• Record an audio CD directly from line-in and microphone. 
• Rip your music collection with NTI Ripper. 

Photo 

 

• Create a photo disc. 
• Create a Cinematic Slideshow CD. 
• Create a VCD/DVD Slideshow. 

Backup 

 

• Launch NTI Shadow to backup your files continuously. 
• Launch NTI Backup NOW! 5 for FTP backup/restore, hard drive spanning, and profile backup. 
• Clone a disc. 

Video 

 

• Launch NTI Home Video Maker to compile, arrange and customize your image and video files into 
a unique presentation. 

• Launch Digital Flix to watch, record, pause, replay live TV/teletext program or listen to digital radio on 
your PC. 

• Launch DVD Fit to view, organize, and customize the desired content of your compressed DVD 
movie. 

• Burn DVD-Video 
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• Create a VCD/SVCD 
• Create a Cinematic Video CD 

Data 

 

• Create a data CD/DVD 
• Create a CD Extra CD (audio and data) 
• Create a mixed-mode CD (audio and data) 

Utilities 

 

• Launch NTI Test Drive to analyze the performance and get information about your hard drive and 
various media types. 

• Launch NTI Session Explorer to see the sessions on your CD/DVD. 
• Launch Digital Jack to play audio files. 
• Launch NTI JewelCase Maker to make CD labels. 

 
 

 
Using the Source Pane 
 

Using the Windows Explorer pane 
The Explorer pane is split vertically into two panes. The left pane displays the system resource tree while the 
right pane displays information about the item selected in the resource tree. Generally, the right pane displays 
the files and folders contained in item selected in the resource tree. The two panes may be resized vertically by 
dragging the splitter bar between them. Dragging the splitter bar to the left will display more of the file information 
in the right hand pane while reducing the visible portion of the resource tree in the left-hand pane. 

The information pane has four columns displaying the file/folder name, its size, the file type and the last modified 
date. The files may be sorted on any one of these columns by clicking on the column header. By default, files are 
sorted alphabetically (ascending) by name. Click the Name column heading to sort them in descending order by 
name. Click it again and the files are now sorted in ascending order by name. 

Notes: 
Ñ  Media Maker’s explorer pane will display both the audio tracks and data files/folders found on a CD-Extra 

or Mixed-Mode disc is inserted in a CD drive on your system. 

Ñ For data track layouts, the destination pane will also have a resource tree pane and file information pane 
that resembles the Explorer view found in the source pane. Items can be dropped on either pane and 
positioned accordingly. For Audio or Video CDs, there is no resource tree pane. Items dropped into the 
destination pane will be added to the end of the list. You can move them up or down the list by dragging 
and dropping them where you want them in the track list. 

 
 
 

 
Using Layout Filtering 
 

Media Maker’s layout filtering allows you to select the type of files you would like to view in the Explorer pane. In 
many layouts, the filters are fixed based on the type of CD you are creating. For instance, the Audio CD/DVD 
layout’s filtering is set to only display CD-DA tracks, MP3, WAV and WMA audio files. This makes sense given 
that Media Maker only supports these file types when burning an Audio CD/DVD. 

However, let’s say that you want to copy your mp3 collection onto a CD/DVD-ROM/Blu-ray. You can do this 
simply by setting the data layout filter to *.mp3 and then use the Explorer pane to locate and drag them into your 
Data CD/DVD/Blu-ray layout. 

Notes: 
Ñ By default, empty folders are included in the layout during drag & drop operations. An empty folder is 

defined as any folder not containing any files that match the current filter settings. You may change this 
default setting from the File Types Tab in the Options dialog. 

Ñ You can set the layout filters for all layout types from the File Types Tab in the Options dialog. 
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Using the Destination Pane 
 

For data tracks, the destination pane mirrors the source (Explorer View) pane and operates in much the same 
manner. You can Drag and drop files/folders to new positions within the CD layout image, create new folders, 
rename, or even delete files and folders. It is important to remember that moving, renaming and deleting files 
from the destination pane only impacts the CD layout and not the original files/folders on your system. These 
changes will only affect the file names and directory structure of the virtual CD image and any subsequently 
recorded CD. If you rename a file in the destination pane, the resulting CD will use the new name while the 
original source file name is not changed on the source device. 

Similar to the Explorer view found in the source pane, the left pane of the data track layout contains a resource 
tree. The resource tree works just like the tree found in Windows Explorer. You can expand or collapse branches 
with the click of your mouse. Files and folders can be moved with a drag and drop operation. You can add a new 
folder to your layout or access Cut, Copy, Paste and other frequently used functions through a shortcut menu 
activated by a click of your right mouse button.  

The right-hand pane is an information pane similar to that found in the Explorer View. It has six columns 
displaying the file/folder name, its size, the file type, last modified date, status and its source. The files may be 
sorted on any one of these columns by clicking on the column header. By default, files are sorted alphabetically 
(ascending) by name.  

As mentioned above, the Audio and Video Track layout panes do not contain a resource tree. Instead, they have 
a single pane to drop files. By default, new files are appended to the Track List found in the destination pane. 
Once dropped onto the destination pane, they can be re-ordered in the track list with the mouse. Simply select 
the track to move and drag it to the new position in the list. 

 
 
 

 
Using Multi-Burning 
 

The multi-burning feature allows you to burn on more than one recorder at a time. This feature can be used on 
the following programs in Media Maker 8: 
• Audio CD/DVD • Photo Maker • Cinematic Slideshow 
• Data CD • MP3 CD • Photo Disc 
• Mixed Mode • DVD Fit • VCD/SVCD 
• CD-Extra • Video_TS • Cinematic Video 
• Home Video 

Maker 
• VCD/DVD 

Slideshow 
 

NOTE: Your computer must have at least two or more recorders to use the multi-burning feature. 

Ä  Using Multi-Burning: 

1. Once you have selected and added your audio or data file on the source pane, click on the 
drop-down menu located below the Explorer Window and select Multiple Recorders (Multi-burn). 

 

2. Click on the Burn button to open the Write Disc window and set the following options: 
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Write Disc Options: 

 Mode Type: • Simulate 

• Write (Default) 

Copies: Select the number of discs to copy. 

Speed: • Maximum - The program will set the extraction to the fastest speed available for the best 
possible extraction quality. 

• Minimum - The program will set the extraction to the slowest speed available for the best 
possible audio extraction quality. 

Shut down option: Click on the check box to shut down computer when the task is completed. 

Drive selection: Select the drives to include for multi-burning. 

Write Method (Advanced Options): 

Smart decision: The program will automatically decide the write method. 

Track-At-Once: (close session, leave disc open; leave session and disc open; close session and disc) 

Session-At-Once: With Session-At-Once writing mode, the CD recorder’s laser does not stop until the all data 
from the current session is written to disc. Session-At-Once is related to the process of 
recording multisession discs. 

Disc-At-Once: With Disc-At-Once writing mode, the CD-Recorder laser will not stop until the entire disc 
has finished recording. The disc is closed, and there are no link blocks between any two 
tracks. 

3. Click on Start to begin multi-burning. 
 
 

 
Working with Audio Files 
 
Audio - Basic Configuration 
 

 

Audio CD - Compile and write your audio 
files onto a CD. You can also edit your CD 
layout properties, convert files, erase discs 
and set other options. 

 

MP3 CD - Compile and write your MP3 
files onto a CD. You can also edit your CD 
layout properties, convert files, erase discs 
and set other options. 

 

Audio Editor - Audio Editor is an 
easy-to-use utility that allows you to cut 
and paste sound clips and add various 
effects to your wave (.wav) file library.  

 

Music DVD - Compile and write your audio 
files onto a DVD. You can also edit your 
CD layout properties, convert files, erase 
discs and set other options. 

 

NOTE:  Music DVD and Live Audio is only available 
on Media Maker 8 Premium Version.  

Live Audio - Records live input from 
either a microphone or other devices 
connected to your sound card and 
write it to an audio track on the disc. 
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Ripper - Compile and rip your audio files 
into a play list. You can also edit your MP3 
encoding quality, configure your volume 
balancing, and set other options. 

 
 

 
Using Tag-Editor 
 

The Tag-Editor feature allows you to organize your MP3 or WMA files by being able to add and edit information 
about your file. 

Ä  Using Tag-Editor 

1. Once you have selected and added your audio file on the source pane, right-click on file and select 
Tag Editor. 

2. Enter the following information about your MP3 or WMA file: Artist, Title, Album, Year, Track Number, 
Genres, and Comment. You can use the Previous Track or Next Track buttons to scroll through the 
tag information. 

 

3. Click on OK to finish. 
 
 

 
Making an Audio CD/DVD 
 
Step 1 - Creating an Audio CD/DVD Layout 
 
Opening a new Audio CD/DVD layout 
 

Ä To open a new Audio CD/DVD layout: 

1.  Click the Audio icon on the Home Screen. 

Note: 
Ñ If you are in a different layout then you can click the Home button on the toolbar to return to the 

Home Screen. 

2.  Select Audio CD/DVD from the Audio Menu. 

Once you choose the Audio CD/DVD layout, Media Maker will display the layout area with an Audio Track Layout 
in the destination pane. Always remember to save your Audio CD/DVD layout once you have created it even 
though it is blank. You should save your layout file often enough to reduce the risk of losing your work. By default, 
Media Maker will use the .CDM extension name for Audio CD/DVD Virtual images. 
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Building an Audio CD/DVD layout 
 

To build your Audio CD/DVD layout, you can import audio tracks from either your CD-ROM drive, MPEG-1 Layer 
3 (.mp3) files, WMA files or Wave (.wav) files from your hard disk. Importing files is easy with Media Maker. 
There are three basic ways to import files into your Audio CD/DVD layout.  

Ä  Using the Add file Method: 
You can manually select files to be imported by clicking the Add button on the toolbar or choosing the 
Add… item from the Track Menu. When selected, Media Maker displays a standard Open dialog box 
allowing you to select the files to be imported. 

As discussed above, Media Maker will display an Explorer view when creating or editing an Audio CD/DVD 
layout. From this view, you can select the files or folders you wish to import and drop them to the desired position 
in the audio track layout.  

Ä  To add an audio track to the Audio CD/DVD layout: 

1.  Navigate the resource tree to locate the desired audio track. 
2.  Click on the desired file or folder. 
3.  Hold the mouse button down while dragging the selection to the destination pane. 
4.  Release the mouse button to drop the selected track in the destination layout. 

Note: 
Ñ Media Maker’s explorer pane will display both the audio tracks and data files/folders found on a 

CD-Extra or Mixed-Mode disc is inserted in a CD drive on your system. 

Ñ When an Audio CD/DVD is used as a source and you are online, Media Maker automatically 
looks for that CD in an online database. If a match is found, all albums, track and artist 
information is updated from the online database. This information is kept and automatically 
inserted in the appropriate CD Text entries when you burn CD containing tracks from an Audio 
CD/DVD. 

Ñ Media Maker automatically converts .mp3, .wma and .wav files to CD-DA tracks before they are 
written to the resulting Audio CD/DVD disc. 

Ñ Currently, WMA encoding is not available when running Windows 2000 or XP. 

Ä  Using Play Lists (Drag-and-Drop): 
It is also possible to create an Audio CD/DVD layout from your favorite Music Café play lists. All .m3u 
compatible play list files may be dropped directly onto the CD Layout. Media Maker will import all 
necessary track information from the play list.  

Note: 
Ñ The .m3u play list format is supported by other popular media players like WinAMP and Music 

Match. Check your media player to see if it supports the .m3u play list format. 
 
 

 
Editing an Audio CD/DVD layout 
 

After you build your Audio CD/DVD layout, you can edit the layout to suit your preference. 

Ä  To delete an audio track from the Audio CD/DVD layout: 

1.  Select the audio track to delete from the track list. 
2.  Click Delete on the Media Maker toolbar. 
3.  Click "Yes" to confirm the deletion. 

Note: 
Ñ  The delete function is also available from the Edit and Quick Command Menus. 
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Ä  To move an audio track to a new position in the track list: 

1.  Select the audio track to move. 
2.  While holding down the left mouse button, drag the selection to the desired position in the track list. 
3.  Drop it in the new location by releasing the left mouse button. 

Note: 
Ñ Media Maker displays a horizontal line across the track list to indicate where the track will be 

dropped in the track list.  

Ä  To play an audio track from the Audio CD/DVD layout: 

1.  Select the audio track to play from the track list. 
2.  Choose the Play item from the Track Menu. 

Note: 
Ñ  The play function is also available from the Quick Command Menu. 

Ä  To view the track properties of an audio track in the Audio CD/DVD layout: 

1.  Select the desired audio track from the track list. 
2.  Click Properties on the Media Maker toolbar. 
3.  Click OK to close the Track Properties dialog and make any requested changes. 

Note: 
Ñ  The properties function is also available from the Track and Quick Command Menus. 

 
 

Setting the Audio CD/DVD Layout Properties 
 

The Audio CD/DVD Properties dialog allows you to set the following: Title, Performer, Songwriter, Composer and 
Arranger. 

Ä  To view/set the Audio CD/DVD layout properties: 

1.  Click CD Layout Properties button on the toolbar. 
2.  View/modify the CD Layout properties as desired. 
3.  Click OK to close the Audio CD/DVD Properties dialog and make any requested changes. 

Note: 
Ñ The CD Layout Properties… item is also available from the Track and Quick Command Menus. 

Notes: 
Ñ Audio CD/DVD Properties (CD Text) are available for audio tracks recorded in the first session written in 

either Session-At-Once (SAO) or Disc-At-Once (DAO) writing modes. It is not mandatory to create entries 
in any of the fields but it is highly recommend that you enter the Title and Artist information. 

Ñ You can click the corresponding Apply to All Tracks button to copy the information entered to all tracks of 
this CD or Layout. 

 
 
 

 
Step 2 - Writing a Disc 
 
Writing an Audio CD disc 
 

After you finish editing your Audio CD/DVD layout, you can start recording. It is a good idea to perform a test 
simulation to reduce the risk of errors. 

There is a difference between recording an Audio CD/DVD disc and recording a CD-ROM disc. For CD-ROM 
disc recording, Media Maker will try to write a single track to reduce the overhead of gaps in between tracks. 
However, in Audio CD/DVD disc recording, one track from the Audio CD/DVD image is one track on the disc. 
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After a successful simulation, you can write to the disc. The steps to write your Audio CD/DVD are the same as 
those for a test simulation. You must either select the Test & Write or Write option from the Write CD dialog box. 
Review the other settings and click Start to record your new CD. 

Note: 
Ñ Remember to set the Volume Balancing and CD Text options from the Write CD dialog. Please consult Write 

CD Options in Chapter 3 for specific information on these options. 
 
 

 
Using Audio Swapping 
 

In addition to using sound files like .mp3, .wav & .wma, you can create an Audio CD/DVD that includes tracks 
from one or more Audio CDs. Simply drag all your favorite tunes from your CD collection into the Audio layout 
and then burn your CD. Media Maker will prompt you for all CDs necessary and save any CD-DA track to your 
temporary directory before burning the desired Audio CD/DVD. 

Ä To burn an Audio CD/DVD using Audio Swapping: 

1.  Create your Audio Layout as described above. 
2.  Insert the Audio CD/DVD you wish to copy tracks from into the CD/DVD ROM. 
3.  Select the desired source CD drive from the resource tree. 
4.  Drag and drop the tracks you want to copy to the Audio Track Layout. 

Notes: 
Ñ Media Maker will ask you if you want to extract the file from the source CD now or wait until the 

Audio Layout has been completed. If you want Media Maker to copy the extract the audio track 
to your system now then choose the "Yes" option and click continue. Choosing the "No" option 
will extract all CD-DA tracks before burning the Audio CD/DVD.  

Ñ You can click the browse button to select a new temporary directory if necessary. 
Ñ Check the Don’t Ask Again box to have Media Maker remember your preference for future 

Audio Swapping operations. 

5.  Repeat steps 4 and 5 to copy additional tracks from the current Audio CD/DVD. 
6.  Repeat steps 2 thru 4 to copy additional tracks from a different Audio CD/DVD. 
7.  Click Step 2 to burn your compilation CD.  

Notes: 
Ñ  Media Maker will now create temporary copies of any audio tracks in your layout from the CD 

that is currently in the source CD drive. Should any tracks in the current layout not be found on 
the CD currently in the source drive, you will be prompted to enter the CD containing that track 
and press "Retry." This will continue until all CD-DA tracks have been found and copied to the 
Program Cache Buffer directory. 

Ñ  If you do not have enough free disk space to hold your temporary audio files an error message 
is displayed. You can either make more space available on your hard drive or switch temporary 
directory to a different hard drive by changing the "Directory for Program Cache Buffer" setting 
on the General Tab of the Options settings. The Options settings can be displayed by selecting 
the Options… item from the Tools Menu. 

8.  If you are using the same drive as both the source and the target CD Maker will prompt you to 
"Please insert a recordable CDRW or CD-R disc into the CD-Recorder" after it has coping all 
necessary CD-DA tracks. Insert a blank disc and press "OK." 

9.  Click Yes at the "Do you still want to continue?" prompt. 
10.  Choose the writing options you want and click "Start" to burn your Audio CD/DVD. 
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Audio File Conversions 
 
Converting a CD-DA Track to an Audio File 
 

You can convert a selected audio track from an Audio CD disc to any of the supported audio file formats. 

Ä  To convert a CD-DA track to an Audio file: 

1.  Select the CD-DA track to be converted from the track list. 

2.  Choose the Convert Audio File Format… item from the Track Menu or right click on the selected CD-DA 
track and choose Convert/Extract. 

3.  Enter the new name and path information. By default, Media Maker uses the same path as the source 
file. A .wav file extension will be automatically appended to the given file name. 

4.  Select the desire file format option from the Save as type list. 

5.  Click Save 

Notes: 
Ñ Unlimited MP3 encoding is available on Media Maker Premium. All other versions offer MP3 encoding on 

a trial basis only! The trial lasts for twenty (20) conversions or thirty-days (30) days from the installation 
date. Please visit our website to upgrade your version of Media Maker to Media Maker Premium. 

Ñ If there is not enough space on the selected hard disk drive, a warning message box will be displayed. 

Ñ The Convert Audio Format function is also available by right clicking on the desired track and selecting it 
from the Quick Command Menu. 

Ñ Currently, WMA support is not available when running Windows 2000 and XP. 
 
 

 
Audio File Format Conversions (Wave, WMA and MP3) 
 

You can convert any supported audio file format to another with Media Maker.  

Ä  To convert an audio file to another format: 

1.  Select the audio file to be converted file from the track list. 
2.  Choose the Convert Audio Format… item from the Track Menu, or right click on the selected audio 

file and choose Convert/Extract. 
3.  Enter the new name and path information. By default, Media Maker uses the same path as the 

source file. The appropriate file extension will be automatically appended to the given file name. 
4.  Select the desired audio format option from the Save as type list. 
5.  Click Save 

Notes: 
Ñ Unlimited MP3 encoding is available on Media Maker Premium. All other versions offer MP3 

encoding on a trial basis only! The trial lasts for twenty (20) conversions or thirty-days (30) 
days from the installation date. Please visit our website to upgrade your version of Media 
Maker to Media Maker Premium. 

Ñ If there is not enough space on the selected hard disk drive, a warning message box will be 
displayed 

Ñ The Convert Audio Format function is also available by right clicking on the desired track and 
selecting it from the Quick Command Menu. 

Ñ Currently, WMA support is not available when running Windows 2000 and XP. 
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Making a MP3 or WMA CD (Premium Version Only) 
 
Step 1 - Creating a New MP3 or WMA CD Layout 
 
Opening a new MP3 or WMA CD layout 
 

The first step in making your MP3/WMA CD is to create or open a MP3 or WMA CD layout and save it. 

Ä  To open a new MP3 or WMA CD layout: 

1.  Click the Audio icon on the Home Screen. 
Note: 
Ñ If you are in a different layout then you can click the Home button on the toolbar to return to the 

Home Screen. 
2.  Select MP3 CD or WMA CD from the Audio Menu. 

Once you choose the MP3 or WMA CD layout, Media Maker will display the layout area with a Data Track Layout 
in the destination pane. Always remember to save your MP3 or WMA CD layout once you have created it even 
though it is blank. You should save your layout file often enough to reduce the risk of losing your work. By default, 
Media Maker will use the .CDM extension name for MP3 or WMA CD Virtual images. 

 
 

 

 

Building a MP3 or WMA CD layout 
To build your MP3 or WMA CD layout, you can import audio tracks from either your CD-ROM drive, MPEG-1 
Layer 3 (.mp3) files, WMA files or Wave (.wav) files from your hard disk. Importing files is easy with Media Maker. 
There are four basic ways to import files into MP3 or WMA Audio CD layout.  

Ä  Using the Add File Method: 
You can manually select files to be imported by clicking the Add button on the toolbar or choosing the 
Add… item from the Track Menu. When selected, Media Maker displays a standard Open dialog box 
allowing you to select the files to be imported. 

As discussed above, Media Maker will display an Explorer view when creating or editing a MP3 or WMA CD 
layout. From this view, you can select the files or folders you wish to import and drop them to the desired position 
in the audio track layout.  

Ä  To add an audio track to the MP3 or WMA CD layout: 

1.  Navigate the resource tree to locate the desired audio track. 
2.  Click on the desired file or folder. 
3.  Hold the mouse button down while dragging the selection to the destination pane. 
4.  Release the mouse button to drop the selected track in the destination layout. 

Note: 
Ñ Media Maker’s explorer pane will display both the audio tracks and data files/folders found on a 

CD-Extra or Mixed-Mode disc is inserted in a CD drive on your system. 

Ä  Using Play Lists (Drag-and-Drop): 
It is also possible to create a MP3 or WMA CD layout from your favorite Music Café play lists. All .m3u 
compatible play list files may be dropped directly onto the MP3 or WMA CD Layout. Media Maker will 
import all necessary track information from the play list.  

Note: 
Ñ The .m3u play list format is supported by other popular media players like WinAMP and Music Match. 

Check your media player to see if it supports the .m3u play list format. 
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Ñ Media Maker automatically converts CD-DA, .mp3, .wma, and .wav files before they are written to the 
resulting MP3 or WMA CD. 

Ñ Currently, WMA encoding is not available when running Window 2000 or XP. 
 

 
 

 
Creating a play list for a MP3 or WMA CD Layout 
 

Ä  To create a play list for your MP3 or WMA CD layout: 

1.  Click the Play list button on the MP3 or WMA CD layout. 
2.  Drag and drop the mp3 tracks in the desired play sequence. 
3.  Click Ok to save the changes to your play list and close the Play list dialog. 

Note: 
Ñ The Audio Tracks are written to the CD in the order specified in the layout and will be played in that 

order when the CD is played from a MP3/WMA player. 
Ñ You can use the Shuffle button to randomly create the playing sequence or Reset to return to the 

original play sequence. 
 

 
 

Editing a MP3 or WMA CD Layout 
After you build your MP3 or WMA CD layout, you can edit the layout to suit your preference. 

Ä  To delete an audio track from the MP3 or WMA CD layout: 

1.  Select the audio track to delete from the track list. 

2.  Click Delete on the Media Maker toolbar. 

3. Click "Yes" to confirm the deletion. 

Note: 
Ñ The delete function is also available from the Edit and Quick Command Menus. 

Ä  To play an audio track from the MP3 or WMA CD layout: 

1.  Select the audio track to play from the track list. 

2.  Choose the Play item from the Track Menu. 

Note: 
Ñ  The play function is also available from the Quick Command Menu. 

 
 

 
Step 2 - Writing a Disc 
 
Test Writing a disc (Simulated Recording) 
 

After you finish editing your MP3 or WMA CD layout, you can start recording. It is a good idea to perform a test 
simulation to reduce the risk of errors. 

 
 

 
Writing a MP3 or WMA CD disc 
 

After a successful simulation, you can write to the disc. The steps to write your MP3 or WMA CD are the same 
as those for a test simulation. You must either select the Test & Write or Write option from the Write CD dialog 
box. Review the other settings and click Start to record your new CD. 
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Making a Live Audio CD Disc (Premium Version Only) 
 
Step 1 - Creating a Live Audio CD Layout 
 
Getting Started 
 

Live Audio refers to recording live audio input from a microphone or other audio source to an audio track on a 
CD-R disc. It might be that you wish to record some piece of music from your personal collection. You can do 
this with Media Maker and live audio recording. Media Maker will record live input from either a microphone or 
other devices connected to your sound card. You can connect a microphone to the microphone port of the sound 
card or any other device that can connect to the Line In port of your sound card. Media Maker will collect the live 
audio information passed to it by the sound card and write it to an audio track on the disc. 

Note: 

Ñ Live audio recording requires that your drive support 1x writing to CD-R media. 

 
 

 
Opening a new Live Audio layout 

Ä To open a new Live Audio layout: 

1.  Click the Audio icon on the Home Screen. 

Note: 
Ñ If you are in a different layout then you can click the Home button on the toolbar to return to the 

Home Screen. 

2.  Select Live Audio from the Audio Menu. 

Once you open a Live Audio layout, Media Maker will display an audio track layout in the destination pane. The 
source pane is not required since all audio input is coming from either the microphone or line-in jacks of your 
PC’s sound card. You simply select the input source from the Audio Source combo box. 

Live Audio works different from the other CD types mentioned previously. There is no actual layout file required 
as the audio information is retrieved from your sound card and written directly to the CD-R media. All the 
recording is done during Step Two. 

 
 

 
Adjusting the volume for Live Audio recording. 
 

Ä To adjust the volume for Live Audio CD recording: 

1.  Double-click the Volume Control icon on the system tray next to the time. 
2.  Select the Properties item from the Options Menu. 
3.  Select the "Recording" option. 
4.  Place a check mark next to the Line-In or Microphone box (depending on your audio source) and 

Press OK. 
5.  Place a check mark in the "Select" box to choose either Microphone or Line-in (depending on your 

audio source). 
6.  Minimize, but do not close Volume Control dialog box. 
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Step 2 - Write a Live Audio CD disc 
 
Write a Live Audio CD disc 
 

Simply click the Step 2 button from the layout area to write your Live Audio disc. Media Maker displays a Record 
Live Audio dialog when you click the Step 2 button.  

Clicking the Start button causes Media Maker to record the live audio data coming from your system’s sound 
card and start recording it to disc. Simply click Stop to end the recording process.  

Once all the audio data is written to the CD-R disc a "Recording Finished" message appears in the Record Live 
Audio dialog and the Close and Start buttons are again enabled. You can record additional Live Audio samples 
or click "Close" to end your live audio recording. You will be asked if you wish to close the session once you 
have exited the Record Live Audio dialog. You should leave the session open if you have more data to record on 
this disc. It is a good idea to leave your session open until you have recorded all the desired audio selections. 

Note: 
Ñ Select the "Disc Image Writer" as the recorder to save the Live Audio recording to a wave file for later 

use. 
 

 
 

Audio Track Properties 
 
Viewing Audio Track Properties 
 

You can view the properties for any audio track in your layout.  

Ä  To view the track properties of an audio track in the Audio CD layout: 

1.   Select the desired audio track from the track list. 
2.   Click Properties on the Media Maker toolbar. 
3.   Click OK to close the Track Properties dialog and make any requested changes. 

Note: 
Ñ  The properties function is also available from the Track and Quick Command Menus. 
 

General Tab 
 

The General tab contains track title, number and description information for the selected audio track. 

Track Title 
This is a text description of the track. Note that it will not be written to the disc - it is just for reference. You 
can give a new title to the selected track. For example, you can type in the corresponding song name in 
place of the default title "Track 6". 

Track Number 
You can update the Track Number in this field. This is an alternative method to move the track. 

 
 

CD Text Tab 
 

The CD Text tab allows you to include additional information about the selected track including the Performer, 
Songwriter, Composer and Arranger. 

Title 
Displays the track’s title information. 
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Performer 
Displays the track’s performer. 

Songwriter 
Displays the track’s writer. 

Composer 
Displays the track’s composer. 

Arranger 
Displays the track’s arranger. 

Notes: 
Ñ These fields must be filled in to correctly record CD Text information on your Audio CD. Your recorder must 

support the writing of CD Text (See the Write Tab of the Drive Properties dialog to verify your drive’s 
capabilities.) You must also check the CD Text box of the Write CD dialog to enable the writing of CD Text 
information during the creation of an Audio CD. 

Ñ You can click the corresponding Apply to All Tracks button to copy the information entered to all tracks of this CD 
or Layout. 

 
 
 

 
 
 
Working with Backup Files 
 
Backup - Basic Configuration 
 

 

Shadow - Schedule continuous backup jobs that 
copy the contents of one or more folders (the 
"backup source") to another location (the "backup 
destination").  

 

Backup Now - Backup and restore across multiple 
discs, multiple hard drives, and using an FTP server. 

 

 

Copy - Copy from a CD disc to a CD-R disc (in a 
CD-Recorder) when both drives are connected to the 
PC.  

NOTE:  Backup Now and Shadow is only available on Media Maker 8 Premium Version. 
 
 

 
Copying a CD Disc 
 
Getting Started 
 

Copying a CD/DVD has never been easier than using Media Maker. Media Maker’s Copy feature enables you to 
make a copy from a CD disc to a CD-R disc (in a CD-Recorder) when both drives are connected to the PC. This 
functionality is similar to that of the DOS "disk copy" command for floppy diskettes except for CD discs. When 
you have both a CD reader and a CD writer, no hard disk space is required to duplicate the source CD, copying 
the CD can be done on the fly! 
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Step 1 - Select Source and Target Drives 
 
Selecting the Copy CD Function 
 

Ä  To select the CD Copy function: 

1.  Click the Copy icon on the Home Screen. 

Note: 
Ñ If you are in a different layout then you can click the Home button on the toolbar to return to the 

Home Screen. 

After opening the Copy window, Media Maker checks your system for the presence of CD-ROM devices. If you 
have both a CD Reader and a CD Recorder, it will automatically select the reader as the source drive and the 
recorder as the target. It will list all CD/DVD drives in the CD-Drive combo box and all CD-Recorders in the CD 
Recorder combo box. You may select any CD device as the source and any CD Recorder as the target. Once 
these devices are selected, Media Maker verifies the media in each device. The amount of information on each 
disc is displayed. 

 
 

 
Copying Source to Hard Disk Before Copy 
 

Ä  To copy the source data to the hard disk before a copy operation: 

1.  Check the Copy to Hard Disk box on the Copy CD layout. 

Note: 
Ñ This option is safer than on-the-fly recording but takes a longer time and requires that more 

hard disk space be available on your machine. 
 

 
 

 
Creating a Disc Image File 
 

Ä  Creating a Disc Image File: 
You can use Copy to create a Disc Image file (.ncd) of your favorite CDs and save it on your hard drive. 
Simply select the Source drive as usual and choose Disc Image Writer from the Target drive list. All you 
have left to do is click Step 2 to create the image. 

Alternatively, you will be asked if you want to save the temporary image file created when using the copy 
source to hard disk option. 

Ä  Creating a CD/DVD from an Existing Disc Image File: 
It is also possible to burn one or more CDs/DVDs from an existing Disc Image file (.ncd) using Copy. 
Simply select the Disc Image Reader from the Source drive list and choose the target drive as usual. All 
you have left to do is click Step 2 to create the CD/DVD. 

 
 

 
Step 2 - Copy and Compare the Discs 
 
Copy the Disc 
 

Once you have selected the source and target drives from step one, the final step is to copy the disc. Simply 
click the Step 2 button to start the copy process. 

Note: 



17 

Ñ Attempting to copy non-standard CDs (i.e. multisession Audio CDs) may produce unpredictable results. 
 

 
 

 
Comparing Discs 
 

Ä  To compare CDs/DVDs: 

1.  Choose Compare Discs from the Tools menu. 

Notes: 
Ñ  Media Maker will display the Copy dialog box and begin the compare operation. Should any difference be 

found the compare operation is halted and a message is displayed indicating the two Discs are not the 
same. 

Ñ  Audio tracks will fail to compare in most instances. For this reason, the Compare Discs function will skip all 
audio tracks during the compare operation. Only the data track of a Mixed-Mode or CD Extra disc will be 
compared when using this function. 

 
 
 

 
Working with Data Files 
 
Data - Basic Configuration 
 

 

Data Disc -  Create a data CD/DVD/Blu-ray by 
validating your data layout to the selected standard 
format and make it ready for recording. 

 

CD-Extra - Create two sessions on the CD 
containing audio and data tracks from your layout. 

 

 

Mixed Mode - Create a Mixed-Mode disc containing 
one track of CD-ROM data followed by one or more 
Audio CD tracks.  

 
 

 
Making a Data CD, DVD or Blu-ray 
 
Step 1 - Creating a Data CD, DVD or Blu-ray Layout 
 
Opening a new Data layout 
 

The Data CD layout can be used to create CD-ROM or CD-ROM XA discs. DVD-ROM discs are made from the 
Data DVD layout.  

Ä  To open a new Data CD/DVD/Blu-ray layout file: 

1.  Click the Data icon on the Home Screen. 

Note: 
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Ñ If you are in a different layout then you can click the Home button on the toolbar to return to the 
Home Screen. 

2.  Select Data CD, Data DVD, or Data Blu-ray from the Data Menu. 
 
 

Saving the new layout file 
 

Ä  To save your Data CD/DVD/Blu-ray layout file: 

1.  Choose the Save command from File menu. 
                              or 

2.  Click on the save button on the toolbar.  

 
 
 

Setting the Volume Information 
Volume information is located in the CD Layout Properties dialog box. To change it you must select the CD 
Layout Properties item from the File menu and select the corresponding tab. 

 
 
 

 
Building a Data CD, DVD or Blu-ray layout 
 

To build your Data CD/DVD/Blu-ray layout you will need to import files and/or folders from the source to the 
layout file. Importing files is easy with Media Maker. There are two basic ways to import files into your layout. 

Ä  Using the Add File method: 
You can manually select files to be imported by clicking the Add button on the toolbar or choosing the 
Add… item from the Edit Menu. When selected, Media Maker displays a standard Open dialog box 
allowing you to select the files to be imported. 

As discussed above, Media Maker will display an Explorer view when creating or editing a Data CD, DVD, or 
Blu-ray layout. From this view, you can select the files or folders you wish to import and drop them to the desired 
position in the data track layout.  

Ä To Add a file/folder to the Data CD/DVD/Blu-ray layout (Drag-and-Drop): 

1.  Navigate the resource tree to locate the desired file or folder. 
2.  Click on the desired file or folder. 
3.  Hold the mouse button down while dragging the selection to the destination pane. 
4.  Release the mouse button to drop the selected file/folder in the destination layout. 

 
 
 

 
Editing a Data CD, DVD or Blu-ray layout 

Ä  To move a file or folder in the Data layout: 

1.  Select the file or folder to move. You make this selection from either Resource Tree or Information 
Pane of the Data Track Layout. 

2.  While holding down the left mouse button, drag the selection to the desired location in the Resource 
Tree. 

3.  Drop it in the new location by releasing the left mouse button. 

Note: 
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Ñ Media Maker highlights the home folder as you drag the folder on top of it. The selected file or 
folder will become a branch of the highlighted folder. 

Ä  To copy a file or folder in the data layout: 

1.  Select the file or folder to copy. You make this selection from either Resource Tree or Information 
Pane of the Data Track Layout. 

2.  While holding down the left mouse button, drag the selection to the desired location in the Resource 
Tree. 

3.  Press the Ctrl key while dragging the selection to the new location. 
4.  Drop it in the new location by releasing the left mouse button. 

Notes: 
Ñ  Media Maker highlights the home folder as you drag the folder on top of it. The selected files 

or folders will be copied to the highlighted folder. 

Ñ  The copy and paste functions are also available from the toolbar and the Edit and Quick 
Command Menus. 

Ä  To delete a file or folder from the data layout: 

1.  Select the file or folder to delete. You make this selection from either Resource Tree or Information 
Pane of the Data Track Layout. 

2.  Click Delete on the Media Maker toolbar. 
3.  Click "Yes" to confirm the deletion. 

Note: 
Ñ The delete function is also available from the Edit and Quick Command Menus. 

Ä  To rename a file or folder in the data layout: 

1.  Select the file or folder to rename. You make this selection from either Resource Tree or Information 
Pane of the Data Track Layout. 

2.  Choose the Rename item from the Edit Menu. 
3.  Enter the new name. 
4.  Press the ENTER key to complete the operation. 

Notes: 
Ñ Hitting the Escape key will exit the rename operation and leave the name unchanged. 

Ñ You can also access the Rename function by right-clicking your mouse and selecting it from 
the Quick Command Menu. 

 
 

 
Viewing File or Folder Properties 

Ä  To view the properties of a file or folder in the Data CD, DVD or Blu-raylayout: 

1.  Select the desired file or folder. You make this selection from either Resource Tree or Information 
Pane of the Data Track Layout. 

2.  Click Properties on the Media Maker toolbar. 
3.  Click OK to close the dialog and save your changes you may have made. 

Note: 

Ñ  The properties function is also available from the Edit and Quick Command Menus. 
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Setting the Data CD, DVD or Blu-ray Layout Properties 
 

The Data CD Properties dialog allows you to set the following: File Name Restrictions, Data Format, Volume Info 
and Data & Time. These field definitions will be used to validate your data layout to the selected standard and 
format and make it ready for recording. By default, Media Maker sets these fields to the Joliet file name 
restriction, CD-ROM Mode 1 and Original file date and time, respectively. 

Media Maker provides you with the following options for the file system. 

ISO 9660 standard, level-1 
If you need the disc to be readable on different platforms, you have to choose this command to standardize all 
the file and folder names according to the rules of ISO 9660.  

MS-DOS file names  
If you are certain that the created CD-ROM disc will be used only in a DOS or Windows 3.1 or 3.11 
environment, you can choose this option. 

Joliet  
If the recorded CD will be used on Windows 95 only, in order to resolve the ISO 9660 restrictions and make 
long file names that can be fully read back, you should follow Joliet file name restrictions. 

Romeo  
If a recorded disc is created using this file system, the disc can be read back only under Windows 95 and/or 
Windows NT 4.0. 

UDF (Universal Disk Format Version 1.50) 
UDF supports a maximum volume size of up to 128 terabytes. The maximum file size is equal to the size of the 
volume containing that file. UDF allows up to 255 bytes for a file name. 

 
 

 
Step 2 - Writing a Disc 
 
Automatic file-name restriction checking 
 

Media Maker will automatically perform file-name restrictions checking during the validation phase of a simulated 
recording (Test) or a write operation. This means: 

1.  A CD/DVD/Blu-ray layout (virtual CD image) you create does not have to conform to any file name 
standard. It contains information about the original files and folders that reside on hard disk or floppy or 
CD-ROM drive. 

2.  Before you start to record an image to the disc, Media Maker will automatically validate the Data 
CD/DVD/Blu-ray layout to follow your selected file name standards. 

 
 

Setting the Write Options 
Media Maker displays the Write CD dialog when you attempt to record a CD/DVD/Blu-ray. You may choose to 
Test (Simulated Recording), Test & Write or Write operation. You may also select the Writing Speed and the 
number of Copies from this dialog. The writing method may be selected from the Advanced section of the Write 
CD dialog. The following is a brief description of the Write CD dialog and all associated options: 

Test  
Perform a test recording of the current layout to your CD/DVD/Blu-ray Recorder. This option writes all data 
exactly as it would during the actual writing process except the recorder does not write the incoming data to 
the media. All settings, except for Copies are utilized in the simulation process. 

Test & Write 
Perform a test simulation and upon successful completion write the data to the media. All settings are utilized 
during this operation. 

Write 
Writes the current layout to the CD-R, CD-RW, DVD or Blu-ray media. All settings are utilized during a write 
operation. 

Speed 
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Select the recording to be used in the Test or Write operation. The combo box will list all writing speeds 
supported by the selected CD/DVD/Blu-ray recorder. 

Copies 
Specify the number of copies of the current layout will be written. This setting is not used during the Test 
operation. 

Volume Balancing 
Determines the average volume level of all the tracks in your layout and then adjusts the volume of all tracks 
to that level as they are being written on your Audio CD. This feature creates an Audio CD with all tracks 
recorded at the same volume and eliminates the need to constantly adjust the volume level on your CD 
player to compensate for differences in volume levels in your source audio files.  

Notes: 
Ñ This option is only available when burning an Audio CD 
Ñ This feature can add several minutes to your recording time but can be disabled by unchecking it in 

Write CD dialog. By default, this box is set according to the Preferences Tab in the Media Maker 
Options dialog. 

Write CD Text 
This enables the writing of CD Text information to your Audio CD. 

Note: 
Ñ This option is only available when mastering an Audio CD. Your recorder must support the writing of CD 

Text (See the Write Tab of the Drive Properties dialog to verify your drive’s capabilities.) 

 

 
 

 
Setting the Advanced Write Options 

This displays the Advanced Write options. 

Write Method 
Media Maker supports the following writing methods: 

Smart decision 
Media Maker automatically selects the writing method based on the type of CD/DVD/Blu-ray you are going to 
write. This is the default selection and the best choice in most cases and is indicated by a blue checkmark to the 
right of the selected writing method. 

Track-At-Once 
Track-At-Once writing mode will write one track at a time. Media Maker will copy from the original source to the 
program cache buffer first, and then send them from the program cache buffer to the CD/DVD/Blu-ray recorder, 
which in turn writes to the target disc all on one track. Select one of the following choices to tell Media Maker if 
you wish to leave the session and disc open or closed at the end of the writing process: 

1.  Close session, leave disc open – Closes the session but does not finalize the disc at the end of the 
write operation. 

2.  Leave session and disc open – Does not close the session or finalize the disc at the end of the write 
operation. 

3.  Close session and disc – Closes the session and finalizes the disc at the completion of the write 
operation. 

Session-At-Once 
Session-At-Once writing mode will write all data from a single session at one time. Media Maker will copy all 
source tracks from the original source to the program cache buffer on the hard disk first, and then send them 
from the cache buffer to the CD/DVD/Blu-ray recorder.  

Disc-At-Once 
For Disc-At-Once writing mode, it is required that all the source tracks must be on the hard disk. If you want to 
make a master disc, you must use Disc-At-Once writing mode. 
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Validating the Data CD layout 
 

Media Maker automatically validates your CD layout before a write or simulation test is performed. Remember 
that a virtual image consists of pointers to the source files on your hard disk. If any changes, such as rename, 
delete, or move has occurred to the actual source files, the pointers in the virtual image are no longer valid. 

Media Maker also validates source files from network or removable media. Validation is necessary because once 
the recorder starts recording, if any problem occurs, it may ruin the whole disc. 

 
 
 

 
Test Writing a disc (Simulated Recording) 
 

The Data CD Properties must be completed before attempting a test simulation. 

During a simulation, just as in actual recording, Media Maker will transfer all the data to the recorder. Unlike 
actual an recording, the CD/DVD/Blu-ray-recorder will not actually record the data to the disc. Some older 
CD-recorders do not support such test simulations—in that case, you will not be able to perform this test. 

Ä  To perform a test simulation: 

1.  Click the Step 2 button from the layout area to display the Write Disc dialog box.  
2.  Check Test or Test & Write from the Write dialog box. 
3.  Select the Writing Speed, Number of Copies and any desired Advanced options from the dialog box. 
4.  Click Start to begin simulated recording. 

Notes: 

Ñ Selecting Test & Write will automatically begin the recording of the CD/DVD/Blu-ray once the 
test simulation has successfully completed. This is the default selection in Media Maker. 

Ñ Media Maker can be set to automatically lower the writing if errors are encountered during the 
testing process. This ensures that your CD/DVD/Blu-ray is created using the fastest writing 
speed available to you. See the Preference Tab of the Options dialog (Tools Menu) to this 
setting. 

Ñ The number of copies entry is not used for a test simulation but be sure to make this setting if 
you are using the Test & Write option above. 

When simulated recording is in progress, a status panel will display how much of the recording has been 
completed. Test mode will also be indicated with a green indicator next to the Cache level display. Once you 
successfully finish the simulation, it is time to make your own CD/DVD/Blu-ray. 

 
 
 

 
Writing a Data CD disc 
 

Once you have prepared your Data CD, DVD or Blu-ray layout, you can perform the writing (recording) to a disc. 
Media Maker allows you to test the creation of your CD in two ways. First, Media Maker will validate your layout. 
It checks to see if the files and folders listed in your layout exist on the source drive. If a file is not found then you 
will be prompted for what to do. This validation step occurs just before a test or actual recording of your layout to 
the CD-Recorder. 

Media Maker also will let you do a test recording or simulation of your layout before an actual write is attempted. 
It is a good idea to run this test before creating a CD/DVD/Blu-ray. Once the layout has been verified and a test 
write successfully completed then it is time to write your new CD/DVD/Blu-ray. 

After a successful simulation, you can write to the disc. The steps to write your CD/DVD/Blu-ray are the same as 
those listed above for a test simulation. You must either select the Test & Write or Write option from the Write 
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dialog box. Review the other settings and click Start to record your new disc. Write mode will also be indicated 
with a red indicator next to the Cache level display. 

 
 
 

 
Making a Mixed-Mode or CD Extra Disc 
 
Making a Mixed-Mode CD Disc 
 
Opening a new Mixed-Mode CD layout 
 

Mixed-Mode refers to the combination of CD-ROM and Audio CD formats on the same disc. A Mixed-Mode disc 
contains one track of CD-ROM data followed by one or more Audio CD tracks.  

Ä To open a new Mixed-Mode CD layout: 

1.  Click the Data icon on the Home Screen. 

Note: 
Ñ If you are in a different layout then you can click the Home button on the toolbar to return to the 

Home Screen. 
2.  Select Mixed-Mode from the Data Menu. 

Once you open a virtual Mixed-Mode CD image, Media Maker will display a data track layout in the destination 
pane. The source pane will contain the Explorer view as described in Chapter 3. 

When creating Mixed-Mode CD, Media Maker will record a single session CD with first track of ISO 9660 in 
CD-ROM or CD-ROM XA format from a virtual Data CD layout followed by audio tracks. Media Maker will record 
the data track from an existing Data CD layout or one that you will create. 

Saving your virtual Mixed-Mode CD Layout 
Always remember to save your virtual Mixed-Mode CD layout once you have created it. It is a good idea to save 
a new layout even though it is blank. You should save the layout file often enough to reduce the risk of losing 
your work. By default, Media Maker will use the .CDM extension name for all layout files. 

 
 

 
Step 1 - Prepare the Data Track 
 

Step 1 prepares the data portion (Data CD part) of the Mixed-Mode CD layout. Media Maker selects it 
automatically when you open the new Mixed-Mode CD layout as described above. Please follow the steps 
described in Chapters 3 and 4, "Making a CD-ROM Disc". Once you have created and saved your data track 
layout then click the Step 2 button to move to the audio portion of the Mixed-Mode CD layout. 

 
 
 

 
Step 2 - Prepare the Audio Track 

To prepare the audio portion (Audio CD part), you need to switch to the Audio Track Layout view of the CD 
Image. Please refer to Chapter 5 for specific instructions on working with audio track layouts. 

 
 
 

 
Step 3 - Write the Mixed-Mode disc 
 

Once you have created and saved your audio track layout then the final step is to write your virtual image to disc. 
Simply click the Step 3 button to write your Mixed-Mode disc. 

It is recommended recording only one session on a Mixed-Mode disc.  
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Making a CD Extra Disc 
 
Opening a new CD Extra layout 
 

A Mixed-Mode CD contains data in the first track followed by one or more audio tracks, in a single session. A 
normal audio CD player attempts to play all tracks in succession. This results in a very loud noise and possible 
damage when playing a Mixed-Mode CD in a normal CD player. CD Extra, also known as CD Plus or Enhanced 
CD, is the solution to the above problem. It contains two sessions. The first session contains up to 98 audio 
tracks and the second session contains a data track written in the CD-ROM XA format. 

Playing a CD Extra disc in a normal Audio CD player plays the audio tracks in the first session, and never reads 
beyond the first session, so the data track is never played and the loud noise and possible damage are avoided. 
A CD-ROM drive that is able to read a multisession CD, however, reads the last session on the CD, so it finds 
the data track. The application can then be used to play back the sound. 

Ä To open a new CD Extra layout: 

1.  Click the Audio icon on the Home Screen. 

Note: 
Ñ If you are in a different layout then you can click the Home button on the toolbar to return to the 

Home Screen. 

2.  Select CD Extra from the Audio Menu. 

Once you open a CD Extra layout, Media Maker will display an audio track layout in the destination pane. The 
source pane will contain the Explorer view as described in Chapter 3. 

When creating a CD Extra disc, Media Maker will record two sessions on the resulting CD. The first session will 
contain the audio tracks from your layout. The second session contains a data track using the ISO 9660 naming 
restrictions written in the CD-ROM XA format. Media Maker will record the data track from an existing virtual 
Data CD image or one that you will create. 

Always remember to save your virtual CD Extra layout once you have created it. By default, Media Maker will 
use the .CDM extension name for all layout files. 

 
 

 
Step 1 - Prepare the Audio Track 

Step 1 prepares the audio portion (Audio CD part) of the CD Extra layout. Media Maker selects it automatically 
when you open the new CD Extra layout as described above. Once you have created and saved your audio track 
layout then click the Step 2 button to move to the data portion of the CD Extra layout. 

 
 

 
Step 2 - Prepare the Data Track 

To prepare the data portion (Data CD part) of your CD Extra disc, please follow the steps described in Chapters 
"Making a CD-ROM Disc".  

 
 

 
Step 3 - Write the CD Extra disc 

Once you have created and saved your data track layout then the final step is to write your virtual image to disc. 
Simply click the Step 3 button to write your CD Extra disc. 

 
 

 
Supplement to Making a Data CD or DVD 
Create discs using Disc Spanning 
 

Disc spanning allows you to automatically write more than a disc’s worth of data files onto multiple discs.  
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Ä  To create discs using disc spanning: 

1.  Make sure you have a Data CD or Data DVD layout open. 
2.  Select the desired disc size from the drop-menu box near the bottom of the layout window. 
3.  Add files to your layout as you normally would when building a Data CD or DVD layout. 

Note: 
Ñ Disc spanning is not activated until you have more data than can fit on the chosen disc size. 

Once you have added enough files such that they do not fit on one disc, the CD Info bar is 
updated to show how much space is taken on multiple discs. 

4.  Click Step 2 in the EasySteps® toolbar, or click the Write Disc button on the toolbar. You will be 
asked whether you want to use disc spanning to break up your CD/DVD layout over a number of 
discs. Answer "Yes" to continue. 

5.  Once your layout is verified, the burning process will continue similar to a normal Data CD or DVD 
session, except during the actual writing process you will be prompted to insert additional blank 
media. 

 
 

 
Program Cache Buffer (Temporary Files) 

The Program Cache Buffer contains temporary files that are used to make read and write operations that occur 
during a recording session smooth and reliable. The main usages of the program cache buffer in making a 
CD-ROM disc are listed below: 

1.  In the process of preparing the data to be written to the CD Recorder, Media Maker will group certain 
small files (by default, any file of size less than small size file threshold 200 KB) in bigger temporary files. 
This is done simply to reduce the risk of buffer under-run errors, since otherwise it would take too much 
overhead to open, read, and close small files, potentially causing errors. 

2.  If you are importing files from a network or removable disk, in the process of preparing data to be written 
to the CD Recorder, Media Maker will copy all the files required from the network disk and/or removable 
disk. 

To configure the use of the program cache buffer, choose the Options… item from the Tools menu, and specify a 
path or tell Media Maker to use same folder that is used by the operating system.  

You should specify a program cache buffer directory with enough space to hold future temporary files. If the 
program cache buffer has enough available space to hold the entire temporary files created by Media Maker, the 
recorded data will be written on a single data track on the disc. Otherwise, Media Maker will split the data into 
multiple tracks.  

In the "Network and Removable Disks Support" field, you can turn on or off the "Copy files to the Program Cache 
Buffer Directory, then write them to CD Recorder" option. When this option is turned on, source files residing on 
a network or removable media will be copied into the program cache buffer directory before writing to a disc. 

 
 

 
Erasing a Rewritable Disc 

You can choose either a Quick Erase or Full Erase. The quick erase function overwrites the existing table of 
contents, thus reducing the time it takes to erase a disc to just a few minutes. The full erase function erases all 
data on the disc and takes a considerably longer amount of time to complete. A full erase however restores the 
media to a more reliable state. 

Ä  To erase a CD-RW disc: 

1.  Select the Erase Rewritable disc item from the Tools Menu. 
2.  Select the drive that contains the rewritable media that you would like to erase from the Drive list. 
3.  Select either Quick or Full for the Type of erase option. For reliability reasons, it is recommended 

that you choose the Full erase option. 
4.  Click Start to begin erasing. 

Notes:   
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Ñ Erasing a DVD-RW disc is similar to a CD-RW. A full erase on a DVD-RW will take longer due 
to its increased data capacity.  

Ñ Erasing a DVD+RW disc will only over-write certain data areas rendering all existing data on 
the disc unreadable. 

 
 
 

 
Comparing Files 

After completing CD recording, some users are anxious to delete the original files in the hard drive to increase its 
free space, without comparing the recorded data with original data, as they assume it should be all right.  

However, it is much safer to compare the recorded data with original data before acting on the original files. 

Ä  To compare files: 

1.  Choose Compare Folders from the Tools menu. 
2.  Select the two folders to be compared and then click on OK. 
3.  Media Maker will perform the comparison and list the details in a report. 
 

 
 

 
Disc Info & Tools 
 

This box contains informational fields about the disc, including its Medium Type, Capacity, Free Space, Status, 
and other details regarding all tracks on the disc in the selected CD Recorder. 

Disc Type 
The disc type can be one of the following: (1) CD-DA or CD-ROM disc; (2) CD-I disc; (3) CD-ROM XA disc. 

Re-Writable 
This indicates if the media in the selected drive is a rewritable (CD-RW) disc. 

Disc Status 
1.  Blank Disc: a blank CD-R disc.  
2.  Recordable Disc: not a blank disc but you can still use this disc to record. That means the disc has not 

been finalized yet. 
3.  Unrecordable Disc: either a conventional CD or Disc-At-Once CD-R disc. You cannot use this disc to 

record. 

Used Space 
This field indicates the amount of disc space currently written to on this disc. 

Free Space 
This field shows the free and available space on the disc, as expressed in "minutes: seconds: frames". If you 
insert a finalized or silver disc, this field will be zero, indicating no free space. 

Buttons  

1.  Refresh: When you insert another CD, click this button to display updated information about the new 
CD. Or, when you want to make sure that the contents of the currently inserted disc are correctly 
displayed, click on the Refresh button. 

2.  Close Session: If there are sessions that have remained open, when you highlight the unclosed 
session, the Close Session button will be enabled. You can use this to close that session. Usually, 
there are two possibilities that resulted in a session remaining open: (a) an error occurred during actual 
recording, in which case the session most likely would remain open; (b) you chose the "Leave session 
and disc open" option for the Track-At-Once writing method, which is in the Advanced section of the 
Write CD dialog box. 
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3.  Recover: If the track is damaged, when you highlight the damaged track, the Recover button will be 
enabled. Highlight the damaged track and click on this button to recover it. The recover utility is 
available only when your CD-Recorder supports this function. 

4.  Read Track: You can read a track from CD/DVD. Highlight a track you want to read to your hard disk, 
and then click on the Read Track button. The following dialog box will pop up. 

5.  Compare Track: You can compare a track from CD/DVD. Highlight a track you want to compare to 
your hard disk, and then click on the Compare Track button.  

6.  Erase: The erase button will be enabled if the selected drive is a CD-RW or DVD-RW/+RW device 
with CD-RW or DVD media. You can erase the disc by clicking this button.  

7.  CD Text…: Displays CD Text information about the CD in the selected CD recorder when clicked. 

8.  Help: Displays help information for the Disc Info & Tools dialog when clicked. 

9.  Close: Closes the Disc Info & Tools dialog when clicked. 
 

 
 

 
Working with Photo Files 
 
Photo - Basic Configuration 
 

 

Photo Disc - Create a data CD with JPEG picture files 
only. Most new DVD players can read these discs 
and display the pictures as a slideshow.  

 

VCD/DVD Slideshow - Import image and audio files 
available from your system to create a VCD/DVD 
Slideshow. 

 

 

Cinematic Slideshow - Use the built-in styles to blend 
with your images and music together to give your 
slideshow an appropriate mood. 

 
 

 
Making a SlideShow VCD/SVCD (Premium Version Only) 
 
Step 1 - Prepare the Slide Track List 
 
Opening a new SlideShow layout 
 

Ä To open a new Slide Show VCD or SVCD Layout: 

1.  Click the Video icon on the Home Screen. 

Note: 
Ñ If you are in a different layout then you can click the Home button on the toolbar to return to the 

Home Screen. 
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2.  Select Slide Show VCD or Slide Show SVCD from the Video Menu. 

Once you select the slideshow option, the familiar Explorer view will be displayed in the source pane and a Slide 
Track Layout will be displayed in the destination pane. The Slide Track Layout contains an image pane on the 
left and a Slide Track List on the right that displays Slide, Type, Length and Source for each slide selection 
included in the current layout. 

Always remember to save your virtual Slide Show layout once you have created it. By default, Media Maker will 
use the .CDM extension name for Slide Show layout files. 

 
 

Preparing the Slide Track List 
 

In Step 1, you must create the list of slides to be included on your Slide Show by importing .bmp, .jpg and .gif 
slide image files available from your system. Importing files is easy with Media Maker. Once you have all the 
slides included in your Slide Track List you must set the Playing Time from the Slide Properties dialog for each 
slide on your list. Other editing functions are similar as those found on the VCD/SVCD layouts. Once you have 
created and saved your Slide Track List then click the Step 2 button to move to the background audio portion of 
the Slide Show CD layout. 

 
 

 
Step 2 - Prepare the Background Audio List 
 
Preparing the Background Audio List 
 

To prepare the background audio portion (Audio CD part), you need to switch to the Background Audio List view 
of the Slide Show CD Layout.  

To add background audio to your Slide Show CD, simply add your favorite audio files to the Background Audio 
list. You can add a single audio track that lasts the length of all the slides included in the Slide Track List, you 
can repeat a single audio track as necessary to display all slide images or you can add multiple audio files that 
will be used to synchronize the display of all slide images contained in the Slide Track List. 

 
 

 
Setting the Playing Time for a Slide Image 

As mentioned earlier in this chapter you must set your display time for each slide in your layout. By default, 
Media Maker selects the "Next" option for a slide when it is first added to the Slide Item List. Also remember that 
this option operates differently when you add background music to your slideshow. For slideshows without 
background music, selecting "Next" means that you must manually advance to the next slide using the controls 
of your VCD/SVCD/DVD player. For slideshows that feature background music, selecting "Next" means that this 
slide will play until the start of the next audio track in your background track list. Entering a time value will display 
the selected slide for the time specified before displaying the next frame. 

Note: 
Ñ See the instructions in the next section to view and edit the Slide Properties. 

 
 

 
Step 3 - Write the SlideShow disc 
 
Writing the SlideShow disc 
 

Once you have created and saved your audio track layout then the final step is to write your virtual image to disc. 
Simply click the Step 3 button to write your Slide Show CD. 

 
 

 
Viewing the Slide Properties 
 

You can view the item properties for any video track in your layout. In the Slide Properties dialog box, you will 
see the Slide title, number and description.  
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The Slide Properties are described below: 
From 
This is the file name and location information for the selected slide image. 

Slide Number 
You can update the Slide Number in this field. This is an alternative method to reposition the slide in the 
Slide Track List using the mouse. 

Playing Time 
For slideshows without background music, selecting "Next" means that you must manually advance to the 
next slide using the controls of your VCD/SVCD/DVD player. For slideshows that feature background 
music, selecting "Next" means that this slide will play until the start of the next audio track in your 
background track list. Entering a time value will display the selected slide for the time specified before 
displaying the next frame. 

Apply to All Slides 
Check this box to apply the Playing Time selection to all slides in your layout. 

Set as Default Playing Time 
Check this box to make this Playing Time selection the Media Maker default. 

Source Format 
Displays various information about the format of the slide image including video format and frame size for 
the selected slide. 

Ä To view/edit the slide properties: 

1.  Select the desired slide image from the slide track list. 
2.  Click Properties on the Media Maker toolbar. You can view the properties or make any desired 

changes from this dialog. 
3.  Click OK to close the Item Properties dialog and make any requested changes. 

Notes: 
Ñ All Playing Time values must be entered in seconds. 
Ñ The properties function is also available from the Track and Quick Command Menus. 

 
 
 

 
Making a Cinematic Slideshow (TM) 
 
Step 1 - Adding Images 
 
Opening a New Cinematic Slideshow(TM) Layout 
 

A Cinematic Slideshow™ is like a normal slideshow -- it displays your favorite pictures set to the beat of your 
background music – except Cinematic Slideshows™ are created and edited intelligently by our software. All you 
have to do is add pictures to your layout (JPEG, BMP), pick whatever background music you want (MP3, WAV), 
and then choose from several different Cinematic Slideshow™ Styles that dictate whether your slideshow is 
classy, sentimental, energetic, or totally over-the-top! 

Once you’ve selected the images, music, and style you want, you can save your slideshow as an MPEG video 
file on your hard drive or burn your slideshow as a VCD or SVCD disc. Start creating your own Cinematic 
Slideshow™ by opening a new Cinematic Slideshow™ layout. 

Ä  To open a new Cinematic Slideshow™ layout file: 

1.  If you are not currently at the Home Screen, click the Home button on the toolbar to return there. 
2.  Click the Photo icon on the Home Screen. The Photo submenu will pop up. 
3.  From the submenu, select the Cinematic Slideshow™ option. 

A new Cinematic Slideshow™ layout will appear. Now you can start adding images to your layout. 

Powered by muvee. 
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Adding Images to Your Layout 
 

Step 1 of creating a Cinematic Slideshow™ is to add images to your slideshow layout. Acceptable image file 
formats are JPEG (.jpg) and bitmap (.bmp). 

Ä  To add images to your layout: 

1.  Drag-and-drop the desired image files from the Explorer Pane to the Destination Pane. 
 
 

 
Step 2 - Adding Music 
 
Adding Background Music 
 

The Cinematic Slideshow™ feature analyzes your background music and synchronizes it with the photo 
slideshow. . Before you add your music to the layout, make sure that your files are in Wave (.wav) or MP3 (.mp3) 
format. 

Ä  To add background music to your layout: 

1.  Drag-and-drop the desired music files from the Explorer Pane to the Destination Pane. 

Once the desired sound files are added to your layout, you can change the music playback sequence 
 

 
 

 
Changing the Music Playback Sequence 
 

A Cinematic Slideshow™ plays your background music in sequence. The music’s playback order is determined 
by the order of the sound files in the Destination Pane (from top to bottom). 

Ä  To change the music playback sequence: 

1.  Drag the music files in the Destination Pane up or down to the desired music playback sequence. 

When you are satisfied with the music playback sequence, click Step 3 in the EasySteps® pane to choose a 
Cinematic Slideshow™ Style 

 
 
 

 
Step 3 - Choosing a Style 
 
Choosing a Cinematic Slideshow(TM) Style 
 

The Cinematic Slideshow™ Style you choose helps the software blend your images and music together to give 
the slideshow an appropriate mood. For example, a wedding slideshow should use a style much slower and less 
frantic than a party slideshow. 

The Cinematic Slideshow™ feature comes with many built-in styles. They will usually be enough to make it easy 
to choose an appropriate style. 

Ä  To choose a Cinematic Slideshow™ Style: 

1.  The available styles are listed in the Style Selections Pane. Click on the style you want to select. 
2.  A description of the style appears on the right, and a preview of the style appears below. The preview 

gives you a sense of how your slideshow will be edited. 

Once you have selected a suitable style, click Step 4 in the EasySteps® pane to begin writing your Cinematic 
Slideshow™ 
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Powered by muvee. 
 
 

 
Step 4 - Writing a Cinematic Slideshow(TM) 
 
Writing a Cinematic Slideshow(TM) 
 

Once you have added your image and music files to your layout and selected a style, you are ready to output 
your Cinematic Slideshow™. When you click the Step 4 button in the EasySteps® pane, the Create Cinematic 
Slideshow™ window appears with various options. 

 
 

 
Configuring the Writing Options 
 

The Create Cinematic Slideshow™ window allows you to configure how you want to output your slideshow. 

Ä  To configure the writing options: 

1.  Choose which video format you wish to output in the Output Type section. You can choose to burn 
your slideshow as a Video CD or Super Video CD disc. Once you have decided whether to output as 
VCD or SVCD, you must also choose your VCD/SVCD television standard (NTSC or PAL). 

Note: 
Ñ NTSC is a television format found in North America and Japan; PAL is found in Europe, Hong 

Kong, and the Middle East. 
2.  If you do not wish to create a disc, make sure that the "Do not burn to disc" box is checked. You can 

save your slideshow as an MPEG video file on your hard drive. 
3.  If you want the Cinematic Slideshow™ to be saved on your hard drive in a different location, change 

the "Output File" box to reflect what to name the video file and where to save it. You can do this by 
clicking the button to the right labeled "…" to navigate to the desired folder and input your desired 
filename. 

4.  When you are done configuring the Output Type and Output File options, click OK and your 
slideshow will begin outputting. Depending on the speed of your computer, this may take significant 
time to finish. 

Your Cinematic Slideshow™ will be ready after the burning and writing processes are complete. 
 
 

 
Making a Photo Disc(TM) 
 
Opening a New Photo Disc(TM) Layout 
 

A Photo Disc™ is a data CD with JPEG picture files only. Most new DVD players can read these discs and 
display the pictures as a slideshow. Photo Discs™ are also readable on PC computers because they are regular 
data CDs that contain JPEG files.  

The Photo Disc™ layout is where you organize the desired content of your disc. 

Ä  To open a new Photo Disc™ layout file: 

1.  If you are not currently at the Home Screen, click the Home button on the toolbar to return there. 
2.  Click the Photo icon on the Home Screen. The Photo submenu will pop up. 
3.  From the submenu, select the Photo Disc™ option. 

A new Photo Disc ™ layout will appear. Now you can start adding images to your layout 
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Step 1 - Adding Images to Your Layout 
 

Step 1 of creating a Photo Disc™ is to add your images to the layout. The images must be in JPEG (.jpg) format; 
other image formats are not accepted. 

Ä  To add images to your layout: 

1.  Drag-and-drop the desired JPEG files from the Explorer Pane to the Destination Pane. 

Once the desired images are added to your layout, click on the EasySteps® Step 2 button to start configuring the 
writing options. 

 
 
 

 
Step 2 - Configuring the Writing Options 
 

Once you have prepared your Photo Disc™ layout, you are ready to burn your disc. You will have some options 
to choose how you want your disc to be burned. 

Ä  When your layout is finished: 

1.  If you have not already inserted a blank disc, do so now. 
2.  From the Write CD window, you can choose the speed at which the recorder drive will burn, the 

number of copies to burn, and whether to perform a test write (simulated recording) before writing 
the data to the disc. A test write does not actually write to the disc. 

Note: 
Ñ Performing a test write is beneficial because it ensures that communication between Media 

Maker and your recorder drive is working properly before writing to a disc. However, your disc 
will be burned faster if you choose not to test. 

3.  Clicking the Advanced button will display the Write Method options. The default option for Write 
Method is "Smart Decision," and it is recommended to use this method because it will automatically 
make the best decision how to burn your disc. However, if you want to change the method used to 
burn your disc (Disc-at-Once, Track-at-Once, etc.), click the desired option. 

4.  When you are ready to start writing your disc, click the Start button. 

The progress window will appear, and your disc will start recording. 
 
 

 
Working with Utilities 
 
Utilities - Basic Configuration 

 

Test Drive - Analyze the performance and get 
information about your hard drive and various 
media. 

 

Session Explorer - Retrieve files in the previous 
session from an Incremental or Independent 
Multi-session CD 

 

Digital Jack - Arrange your music files into a play list and 
load/store your presets and set your playback options. 
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Jewel Case Maker - Create and print one or 
two-page front-cover inserts, back-cover inserts, 
and CD labels. 

 
 

 
Session Explorer: Retrieve files from previous session 
 

If you want to retrieve files in the previous session from an Incremental or Independent Multisession CD, you 
cannot do it by using Windows Explorer, as Explorer only reads and displays the contents of the last session.  

The solution is Session Explorer, which provides the tool for retrieving files from any selected session on a CD to 
any selected drive.  

Ä To retrieve files from a previous session: 

1.  Insert the CD from which you want to retrieve files into the CD Recorder. 
2.  Choose the Session Explorer… item from the Tools Menu. 
3.  Media Maker will automatically detect and display the contents from the CD that is loaded in the 

default CD drive. 
4.  Select the files you wish to retrieve from this CD. 
5.  Click "Copy To" to copy the selected files.  
6.  A dialog box will be displayed allowing you to specify the location for the selected files that you want 

to retrieve. 
7.  Media Maker will display a panel indicating the retrieval progress.  

Notes:   
Ñ When a complicated multisession CD is inserted, there may be a slight delay before Media Maker 

is able to display the contents of the inserted CD. 
Ñ Choose Refresh from the Edit menu to refresh the display when you insert another CD. 
 

 
 

 

 
 
Working with Video Files 
 
Video - Basic Configuration 
 

 

Home Video Maker - Compile, arrange and customize 
your image and video files into a unique presentation. 

 

VIDEO_TS - Add your DVD-Video files to this folder to 
compress a movie. You can also edit your CD layout 
properties, convert files, erase discs and set other 
options. 

 

VCD/SVCD - Import MPEG-1 (.mpg) or MPEG-2 (.mpg) 
files available from your system to build your VCD/SVCD 
layout. 
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Digital Flix - Watch, record, pause, replay live 
TV/teletext programs or listen t digital radio on your PC. 

 

Cinematic Video - Give your videos a professional and 
cinematic look by removing the boring or blurry shots, 
adding background music, and inserting transitions. 

 

NOTE:  Home Video Maker is only available on 
Media Maker 8 Premium Version. 

 

DVD Fit - View, organize, and customize the desired 
content of your compressed DVD movie. 

 
 

 
Making a DVD-Video Disc 
 
Step 1 - Creating a DVD-Video Layout 
 
Opening a New DVD-Video Layout 
 

The DVD-Video format is used in regular DVD movies you might buy off the shelf. A DVD-Video disc contains 
special files that store the video and audio data. These files (called VOB files) usually contain video in the 
MPEG-2 format and audio in the AC3 format. DVD-Videos can be played on standalone DVD players as well as 
computers with DVD-ROM drives (provided that you have DVD playback software). 

The DVD-Video layout is where you organize the desired content of your DVD-Video disc. 

Ä  To open a new DVD-Video layout file: 

1.  If you are not currently at the Home Screen, click the Home button on the toolbar to return there. 
2.  Click the Video icon on the Home Screen. The Video submenu will pop up. 
3.  From the submenu, select the DVD VIDEO_TS option. 

A new DVD-Video layout will appear. 
 
 

 
Adding Files to your DVD-Video Layout 

To build your DVD-Video layout, you need to add DVD-Video files to the VIDEO_TS folder in the Destination 
pane labeled "DVD-Video Track Layout."  

The easiest way is to drag-and-drop the necessary DVD-Video files (VOB, IFO, BUP) from the Explorer pane 
into the VIDEO_TS folder. Additionally, if you already have the necessary files organized in a folder named 
VIDEO_TS, you can also choose to drag-and-drop that folder into the layout – all the files that it contains will be 
added to the layout. 

 
 

Renaming a DVD-Video Disc 
New DVD-Video layouts are given a default name. You may want to change the name to better reflect the 
content of your disc. 

Ä  To change the name of your DVD-Video disc: 

1.  Right-click on the DVD-Video disc icon in the DVD-Video Track Layout, and choose the "Rename" 
option. 

2.  Type the desired name of your disc. 
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Saving a DVD-Video Layout 
 

You can save your current layout in case you want to burn the same disc again. 

Ä  Saving a DVD-Video Layout file: 

1.  Choose the Save command from File menu or click on the save button on the toolbar. 
 
 

 
Finishing Up With Step 1 
 

Once you have prepared your DVD-Video layout, you are ready to burn your disc. 

Ä  When your layout is finished: 

1.  Click either the Write Disc button in the toolbar or the Step 2 button on the EasySteps® pane. The 
Write window will be launched. 

Now that you’ve reached Step 2, you are now ready to burn your disc. Continue onto Configuring the Writing 
Options. 

 
 

 
Step 2 - Writing a DVD-Video Disc 
Configuring the Writing Options 
 

Once you have prepared your DVD-Video layout, you are ready to burn your disc. You will have some options to 
choose how you want your disc to be burned. 

Ä  When your layout is finished: 

1.  If you have not already inserted a blank disc, do so now. 
2.  From the Write DVD-Video window, you can choose the speed at which the recorder drive will burn, 

the number of copies to burn, and whether to perform a test write (simulated recording) before 
writing the data to the disc. A test write does not actually write to the disc. 

Note: 
Ñ Performing a test write is beneficial because it ensures that communication between Media 

Maker and your DVD recorder drive is working properly before writing to a disc. However, your 
disc will be burned faster if you choose not to test. 

3.  Clicking the Advanced button will display the Write Method options. The default option for Write 
Method is "Smart Decision," and it is recommended to use this method because it will automatically 
make the best decision how to burn your disc. However, if you want to change the method used to 
burn your disc (Disc-at-Once, Track-at-Once, etc.), click the desired option. 

4.  When you are ready to start writing your disc, click the Start button. 

The progress window will appear, and your disc will start recording. 
 

Making a Video or Super Video Disc 
 
Step 1 - Creating a Video CD/Super VCD Layout 
 
Opening a new Video CD/Super VCD layout 
 

Ä To open a new Video CD/Super VCD Layout: 

1.  Click the Video icon on the Home Screen. 
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Note: 
Ñ If you are in a different layout then you can click the Home button on the toolbar to return to the 

Home Screen. 

2.  Select Video CD or Super VCD from the Video Menu. 

Once you select Video CD from the "New" menu, the familiar Explorer view will be displayed in the source pane 
and a Video Track Layout will be displayed in the destination pane. The source pane will contain the Explorer 
view as described in Chapter 3. The Video Track Layout contains a menu pane on the left and a Video Item List 
on the right that displays Item, Type and Length for each video selection included in the current layout. 

Always remember to save your virtual Video CD/Super VCD layout once you have created it. By default, Media 
Maker will use the .CDM extension name for Video CD/Super VCD layout files. 

 
 

 
Building a Video CD/Super VCD layout 
 

To build your Video CD/Super VCD layout, you can import MPEG-1 (.mpg) or MPEG-2 (.mpg) files available 
from your system. Importing files is easy with Media Maker. There are three basic ways to import video clips into 
your layout.  

Additionally, you can add a menu to your VCD/SVCD layout and you must select either NTSC or PAL video 
output types from the layout pane.  

Ä  Adding video clips to the Video Item List using the Add File Method: 
You can manually select video clips to be imported into your layout by clicking the Add button on the 
toolbar or choosing the Add… item from the Track Menu. When selected, Media Maker displays a standard 
Open dialog box allowing you to select the video clips to be imported to your video item list. 

Ä  To add a video clip to the video item list (Drag-and-Drop): 

1.  Navigate the resource tree to locate the desired video clip. 
2.  Click on the desired video clip to select it. 
3.  Hold the mouse button down while dragging the selection to the destination pane. 
4.  Release the mouse button to drop the selected clip on the video item list. 

Ä  To add a menu image to the VCD/SVCD layout: 

1.  Navigate the resource tree to locate the desired menu image. 
2.  Click on the desired menu to select it. 
3.  Hold the mouse button down while dragging the selection to the destination pane. 
4.  Release the mouse button to drop the selected clip on the menu area. 

Notes: 
Ñ  You can now drag and drop supported .avi files into your VCD layout. Media Maker will test .avi file and 

convert it to the MPEG-1.format prior to burning your VCD. Additionally, you can use Media Maker’s MPEG-1 
encoder tool to convert your AVI files to the MPEG-1 format. You must purchase the AVI to MPEG-2 plug-in to 
perform this conversion for SVCD discs. 

Ñ  An AVI file can encapsulate many different formats of video files. Every AVI file indicates which video CODEC 
(CO - Compressor/DEC - Decompressor) is required to decode the encapsulated video file. You must have 
the required CODECs installed on your system to play or convert a particular AVI file. The general rule is that 
if you can play the AVI file on your Windows Media Player you can convert it using the Media Maker 
MPEG-1/2 Encoder. If you cannot play a given AVI file you can try upgrading to the latest release of Windows 
Media Player from the Microsoft website. 

Ñ  The AVI to MPEG conversion process can take a considerable amount of time and disk space due to the size 
of the files involved. The original AVI file is first decoded into its audio and video components and then 
multiplexed back into the resulting MPEG-1 file suitable for VCD/SVCD mastering. Please make sure you 
have 1 – 2 GB of free disk space on your Windows system drive. 
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Editing the Menu Image 

After you build your Video CD/Super VCD layout, you can edit the menu image in your layout to suit your 
preference. Media Maker will call the graphic editing program specified in the General Tab of the Options 
settings. Once you have edited your menu, save it and then replace the menu in your layout with the modified 
version you just saved. 

Ä  To edit a menu from the Video CD/Super VCD layout: 

1.  Right click on the menu and select Edit. 
2.  Edit the menu image in your favorite graphic editor and save the resulting image. 
3.  Right click on the menu image and choose Replace Menu… 
4.  Select the modified menu image file and click the Open button. 

Note: 
Ñ You can use the Image Editor item located on the General Tab of the Media Maker Options 

settings to check the Use Default Editor box or specify the graphic editor program to use for all 
image editing functions within Media Maker. 

Ä  To delete a video clip from the Video CD/Super VCD layout: 

1.  Select the video clip to delete from the video item list. 

2.  Click Delete on the Media Maker toolbar. 

3.  Click "Yes" to confirm the deletion. 

Note: 
Ñ  The delete function is also available from the Edit and Quick Command Menus. 

Ñ  To delete the menu image from the Video CD/Super VCD layout, right-click the menu image 
and chose Delete. 

Ä  To move a video clip to a new position in the video item list: 

1.  Select the video clip to move. 
2.  While holding down the left mouse button, drag the selection to the desired position in the video item 

list. 
3.  Drop it in the new location by releasing the left mouse button. 

Note: 
Ñ Media Maker displays a horizontal line across the video item list to indicate where the clip will 

be dropped.  

Ñ  When you don’t specify the play order, the item will be shown continuously when it is played 
back until a selection is made by using the remote control. 

 
 

 
Viewing Item Properties 
 

You can view the item properties for any video track in your layout. In the Item Properties dialog box, you will see 
the item title, number and description. The Item Properties are displayed below: 

Item Title 
This is a text description of the item. Note that it will not be written to the disc - it is just for reference.  

Item Number 
You can update the Item Number in this field. This is an alternative method to move the video clip. 

Source Format 
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Displays various information about the format of the video item, including frame size, rate, number of frames 
in the item and play time for the item. 

Ä  To view the track properties of a video clip in the Video CD/Super VCD layout: 

1.  Select the desired video clip from the video item list. 
2.  Click Properties on the Media Maker toolbar. You can view the properties or make any desired 

changes from this dialog. 
3.  Click OK to close the Item Properties dialog and make any requested changes. 

Note: 
Ñ The properties function is also available from the Track and Quick Command Menus. 

Ä  To preview a video clips from the Video CD/Super VCD layout: 

1.  Select the video clip from the video item list. 

2.  Choose the Play item from the Track Menu. 

Note: 
Ñ The play function is also available from the Quick Command Menu. 

 
 
 

 
Setting the Video CD/Super VCD Layout Properties 

The Video CD/Super VCD Properties dialog allows you to set the following:  

Album Tab 

• Album Identification 
This is a text identifier for this album. 

• Number of Volumes in Album 
Specify the number of CD volumes that make up this album. 

• Sequence Number of the Volume 
Specify the sequence number of this volume for this album. 

• Viewing Restrictions 
Specify the viewing restriction for this volume. 

Volume Tab 
The ISO 9660 Standard allows you to describe certain information about the CD. Such information is called 
the Volume Description, and will be recorded on the CD. The following briefly explain the fields in the Volume 
Description. 
• Volume Name 

You can specify an identification of the volume in this field. It allows up to 32 alphanumeric characters, 
which include 0-9 and A-Z. This field is recommended. 

• Volume Set Name 
If the disc you are preparing is part of a set of discs, every disc in the set may have the same name 
recorded in this field. It allows up to 32 d-characters. This field is optional. 

• System Name 
It refers that the operating system under which the application will run. It allows up to 32 a-characters. 
This field is optional. 

• Publisher Name 
You can identify the publisher of the disc. It allows up to 128 a-characters. This field is optional. 

• Data Prepare Name 
You can specify an identification of the person or other entity, which controls the preparation of the data 
to be recorded on the volume. It allows up to 128 a-characters. This field is optional. 

Date & Time Tab 
Specify the below Dates and Times of this CD volume. 

• Creation 
You can specify the date and the time of the day at which the information in the volume was created. 
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• Modification 
You can specify the date and the time of the day at which the information in the volume was last 
modified. 

• Expiration 
You can specify the date and the time of the day at which the information in the volume may be regarded 
as obsolete.  

• Effective 
You can specify the date and the time of the day at which the information in the volume may be used. 
 

 
 

 
Step 2 - Writing a Disc 
 
Writing a Video CD/Super VCD disc 
 

After a successful simulation, you can write to the disc. Before writing to the disc, define the Volume Info and 
Album, which is outlined in Step 1 above. The steps to write your Video CD are the same as those for a test 
simulation. You must select either the Test & Write or Write option from the Write dialog box. A test simulation 
should be done regardless of the type of the image.  

Review the other settings and click Start to record your new CD. 
 
 

 
Using the AVI to MPEG Encoding Tool 
 

Now you can use Media Maker’s new MPEG encoder tool to convert your AVI files into MPEG-1/2 to be used to 
create a VCD/SVCD disc. 

Ä  To convert an AVI file into a MPEG file: 

1.  Select the Convert AVI to MPEG... item from the Tools Menu. 
2.  Enter the name of the AVI file you wish to convert in the Input File area or use the browse button to 

locate the file to convert. 
3.  Select the Output Stream Format. 
4.  Enter the Output File Name. 
5.  Click the Start button to begin the conversion process. 

Notes:   

Ñ You must purchase NTI’s MPEG-2 Encoder Plug-in from our web site to create an MPEG-2 file 
suitable for SVCD recording.  

Ñ Direct X Version 8.0 or above is required to decode AVI files containing a Divx data stream. 
This support is not available for the Windows NT operating system. 

Ñ Click the Play button in the Input File area to preview the selected AVI file. 
Ñ Click the Play button in the Output File area to view the resulting MPEG file. 
Ñ Clicking on the viewing area will pause/continue the preview of the video files 
Ñ An AVI file can encapsulate many different formats of video files. Every AVI file indicates which 

video CODEC (CO - Compressor/DEC - Decompressor) is required to decode the 
encapsulated video file. You must have the required CODECs installed on your system to play 
or convert a particular AVI file. The general rule is that if you can play the AVI file on your 
Windows Media Player you can convert it using the Media Maker MPEG-1 Encoder. If you 
cannot play a given AVI file you can try upgrading to the latest release of Windows Media 
Player from the Microsoft website. 

Ñ The AVI to MPEG conversion process can take a considerable amount of time and disk space 
due to the size of the files involved. The original AVI file is first decoded into its audio and 
video components and then multiplexed back into the resulting MPEG-1 file suitable for VCD 
mastering. Please make sure you have 1 – 2 GB of free disk space on your Windows system 
drive. 
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Making a Cinematic Video (TM) 
 
Step 1 - Adding Videos 
 
Opening a New Cinematic Video(TM) Layout 
 

The Cinematic Video™ lets you take your videos, remove the boring or blurry shots, add background music, and 
insert transitions. It gives your videos a professional and cinematic look – but the best part is that Cinematic 
Videos™ are created, edited, and enhanced automatically by our software. All you have to do is add videos to 
your layout (AVI, MPEG), pick whatever background music you want (MP3, WAV), and choose from several 
different Cinematic Video™ Styles that dictate whether your video is classy, sentimental, energetic, or totally 
over-the-top! 

Once you’ve selected the videos, music, and style you want, you can save your video as an MPEG video file on 
your hard drive or burn your video as a VCD or SVCD disc. 

The Cinematic Video™ layout is where you organize the desired content of your video. 

Ä  To open a new Cinematic Video™ layout file: 

1.  If you are not currently at the Home Screen, click the Home button on the toolbar to return there. 
2.  Click the Video icon on the Home Screen. The Video submenu will pop up. 
3.  From the submenu, select the Cinematic Video™ option. 

A new Cinematic Video™ layout will appear. Now you can start adding videos to your layout. 

 

Powered by muvee. 
 
 

 
Adding Videos to your Layout 

Step 1 of creating a Cinematic Video™ is to add your videos to the layout. Acceptable video file formats are AVI 
(.avi) and MPEG (.mpg). 

Ä  To add videos to your layout: 

1.  Drag-and-drop the desired video files from the Explorer Pane to the Destination Pane. 

Once the desired videos are added to your layout, you can add background music 
 
 

 
Step 2 - Adding Music 
 
Adding Background Music 
 

The Cinematic Video™ feature analyzes your background music and synchronizes it with your videos. Make 
sure that your music files are in the Wave (.wav) or MP3 (.mp3) format. 

Ä  To add background music to your layout: 

1.  Drag-and-drop the desired music files from the Explorer Pane into the Destination Pane. 

Once the desired sound files are added to your layout, you can change the music playback sequence 
 
 

Changing the Music Playback Sequence 
A Cinematic Video™ plays your background music in sequence. The music’s playback order is determined by 
the order of the sound files in the Destination Pane (from top to bottom). 
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Ä  To change the music playback sequence: 

1.  Drag the music files in the Destination Pane up or down to the desired music playback sequence. 

When you are satisfied with the music playback sequence, click Step 3 in the EasySteps® pane to choose a 
Cinematic Video™ Style 

 
 

 
Step 3 - Choosing a Style 
 
Choosing a Cinematic Video(TM) Style 
 

The Cinematic Video™ Style you choose is what helps the software blend your video and music together to give 
it an appropriate mood. For example, a wedding video should use a style much slower and less frantic than a 
party video. 

The Cinematic Video™ feature comes with built-in styles. They will usually be enough to make it easy to choose 
an appropriate style. 

Ä  To choose a Cinematic Video™ Style: 

1.  The available styles are listed in the Style Selections Pane. Click on the style you want to select. 
2.  A description of the style appears on the right, and a preview of the style appears below. The 

preview gives you a sense of how your video will be edited. 

Once you have selected a suitable style, click Step 4 in the EasySteps® pane to begin writing your Cinematic 
Video™ 

 

Powered by muvee. 
 
 

 
Step 4 - Writing a Cinematic Video (TM) 
 
Writing a Cinematic Video(TM) 
 

Once you have added your video and music files to your layout and selected a style, you are ready to output 
your Cinematic Video™. When you click the Step 4 button in the EasySteps® pane, the Create Cinematic 
Video™ window appears with various options to configure your video output. 

 
 

Configuring the Writing Options 
The Create Cinematic Video™ window allows you to configure how you want to output your video. 

Ä  To configure the writing options: 

1.  Choose which video format you wish to output in the Output Type section. You can choose to burn your 
video as a Video CD or Super Video CD disc. Once you have decided whether to output as VCD or 
SVCD, you must also choose your VCD/SVCD television standard (NTSC or PAL). 

Note: 
Ñ NTSC is a television format found in North America and Japan; PAL is found in Europe, Hong 

Kong, and the Middle East. 
2.  If you do not wish to create a disc, make sure that the "Do not burn to disc" box is checked. You can 

still save your video as an MPEG video file on your hard drive. 
3.  If you want the Cinematic Video™ to be saved on your hard drive in a different location, change the 

"Output File" box to reflect what to name the video file and where to save it. You can do this by 
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clicking the button to the right labeled "…" to navigate to the desired location and input your desired 
filename. 

4.  When you are done configuring the Output Type and Output File options, click OK and your video 
will begin outputting. Depending on the speed of your computer, this may take significant time to 
finish. 

Your Cinematic Video™ will be ready after the burning and writing processes are complete. 
 
 

Using DVD Fit(TM) 
Step 1 - Creating a DVD Fit(TM) Layout 
Opening a New DVD Fit(TM) Layout 
 

The DVD Fit™ layout is where you can view, organize, and customize the desired content of your compressed 
DVD movie. 

Ä  To open a new DVD Fit™ layout file: 

1.  If you are not currently at the Home Screen, click the Home button on the toolbar to return there. 
2.  Click the Video icon on the Home Screen. The Video submenu will pop up. 
3.  From the submenu, select the DVD Fit™ option. 

A new DVD Fit™ layout will appear. Next, learn how to add your DVD movie files to the layout by importing a 
VIDEO_TS folder 

 
 
 

Importing a VIDEO_TS Folder 
 

The VIDEO_TS folder of the DVD movie you want to compress needs to be added to the DVD Fit™ layout. You 
can do this by importing the VIDEO_TS folder that contains the movie data.  

Ä To import a VIDEO_TS folder to your layout: 

1.  Click the Import VIDEO_TS button in the upper-left of the DVD Fit™ window. A pop-up explorer 
window will appear. 

2.  In the pop-up explorer window, browse your computer for the location of the VIDEO_TS folder you 
wish to import. Once you have selected a folder, click OK. 

3.  When the VIDEO_TS folder has been imported successfully, the movie information should appear 
as various collapsible folders in the main layout pane. 

 

The next task is to configure your settings 
 

 

Selecting Disc Size and Destination Drive 
 

Selecting a Disc Size 
Select the disc size for your movie by clicking the drop-menu labeled "Fit to:" and choosing the desired disc size.  
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DVD-5 (4.7GB) will compress your movie to fit on single-layer DVD media (DVD±RW). 

 

Selecting a Destination Drive 
Select the DVD recorder you will use to create your DVD movie by clicking the DVD Recorder drop-menu and 
choosing the desired option.  

 

The selected recorder will be the target drive. 
 
 

 
Change the location of the output folder 
 

Even if you plan on writing the movie to a DVD disc, it must be saved somewhere on your hard drive. It is saved 
in a user’s temporary folder by default, but DVD Fit™ allows you to configure where to output the compressed 
movie on your hard drive.  

Ä  To change the location of the output folder: 

1.  Go to the File menu and select Option. The Option Window will appear. 
2.  Click the Browse button and navigate to the desired location of the outputted VIDEO_TS folder. 

When you are finished, click OK. 
3.  Click OK in the Option Window to return to your DVD Fit™ Layout. 

 
 
 

 
Change the amount of video compression 
 

If you are not happy with the default video compression, you can adjust how much the parts of your movie are 
compressed. Increasing the compression will make the size of the video data smaller, but it also decreases the 
picture quality. One way you might use this feature is to tightly compress the unimportant parts of a DVD movie 
to free up extra disc space, and then use that space to maximize the picture quality of the important parts. 

Ä  To change the amount of video compression: 

1.  In the DVD Fit™ explorer, navigate to the folder containing the video you want to adjust. You can do 
this by clicking the plus icons to expand the folders and selecting the folder with the appropriate 
duration and size of the video. 

2.  Once you have selected a folder, click on the Video tab on the upper-right of the DVD Fit™ window. 
The tab will appear in the foreground. 

Note: 
Ñ If you selected a valid video in the DVD Fit™ explorer in Step 1, then the video’s attributes will 

be listed in the box below the tabs (e.g. Compression, Aspect Ratio, Resolution, etc.) 
3.  Drag the slider bar to adjust the amount of compression. Moving it to the left will increase the 

compression, and moving it to the right will decrease compression. 
 

 
 

Remove unwanted audio and subtitles 
 

Many DVD movies come with extra audio tracks. DVD Fit™ can strip your movie of unwanted tracks and free up 
space for other uses such as higher quality video compression. 

Ä  To remove unwanted audio: 
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1.  In the DVD Fit™ explorer, navigate to the folder containing the audio you want to remove. You can 
do this by clicking the plus icons to expand the folders. 

2.  Click on the Audio tab on the upper-right of the DVD Fit™ window. A list of the available audio tracks 
will appear. 

3.  Uncheck any unwanted audio tracks to remove them from your layout. 

The Sub-picture tab is to view or remove the subtitles from your movie. 

Ä  To remove unwanted subtitles: 

1.  In the DVD Fit™ explorer, navigate to the folder containing the audio you want to remove. You can 
do this by clicking the plus icons to expand the folders. 

2.  Click on the Sub-picture tab on the upper-right of the DVD Fit™ window. A list of the available 
subtitles will appear. 

3.  Uncheck any unwanted subtitles to remove them from your layout. 

Once you finish setting up your DVD Fit™ layout, click the Step 2 button in the EasySteps® Pane to start 
transcoding and writing your movie. 

 
 

 
Step 2 - Transcoding and Writing a Movie 
 
Transcoding Your Movie 

The process of compressing a DVD movie is called transcoding. It requires some time to transcode a movie 
because it needs a lot of CPU computations. Not only does it take significant time, but it also uses a lot of hard 
drive space to store the compressed movie. Before you start, check that you have enough free space on a hard 
drive to accommodate your compressed movie. 

Ä  To transcode a movie: 

1.  If you have not already done so, click the Step 2 button in the EasySteps® Pane. 
2.  If your local hard drive does not have enough room to store the compressed video, you will be 

prompted to choose a different location to temporarily store it. 

Note: 
Ñ Remember that the transcoding process takes time, so please be patient. 

After the transcoding has finished, you will be prompted to configure the writing options. 

Configuring the Writing Options 
Once you have prepared your DVD Fit™ layout, you are ready to burn your disc. You can configure how you 
want your disc to be burned. 

Ä  When your layout is finished: 

1.  If you have not already inserted a blank disc, do so now. 
2.  From the Write Disc window, you can choose the speed at which the recorder drive will burn, the 

number of copies to burn, and whether to perform a test write (simulated recording) before writing 
the data to the disc. A test write does not actually write to the disc. 

Note: 
Ñ Performing a test write is beneficial because it ensures that communication between Media 

Maker and your DVD recorder drive is working properly before writing to a disc. However, your 
disc will be burned faster if you choose not to test. 

3.  Clicking the Advanced button will display the Write Method options. The default option for Write 
Method is "Smart Decision," and it is recommended to use this method because it will automatically 
make the best decision how to burn your disc. However, if you want to change the method used to 
burn your disc (Disc-at-Once, Track-at-Once, etc.), click the desired option. 

4.  When you are ready to start writing your disc, click the Start button. 
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The progress window will appear, and your disc will start recording. 
 
 

Miscellaneous 
 
CD Drive Properties 
 
General Tab 
 

The general tab provides product and vendor information about the selected drive. 

Vendor ID – Displays the vendor of the selected drive. 

Product ID – Displays the Product ID String of the selected drive. 

Firmware Version – Displays the firmware version of the selected drive. 

Cache Memory – Displays the amount of cache memory installed on the selected drive. 

Drive Letter – Displays the drive letter of the selected drive. 

 
Write Tab 
 

The write tab indicates the write speeds and supported features of the selected drive. 

Medium Types – This drive supports these media types. 

CD-R Speed – This drive writes to CD-R media at these speeds. 

CD-RW Speed – This drive writes to CD-RW media at these speeds. 

DVD Speed – This drive writes to DVD media at these speeds. 

CD Text – This drive will write the CD-Text information to the media. 

Buffer Underrun Error Protection – This drive supports one of the current buffer underrun error protection 
technologies (i.e. Burn Proof, JustLink, SeamlessLink, ExacLink or SuperLink). 

Overburn – This drive supports Overburning™. 

Disc-At-Once – This drive supports the Disc-At-Once writing method. 

Session-At-Once – This drive supports the Session-At-Once writing method. 

Packet Writing – This drive supports packet writing. 
Write UPC & ISRC – This drive supports the writing of UPC and ISRC code information to the media. 
 
Read Tab 
 

The read tab indicates the supported maximum read speed and supported features of the selected drive. 

Max Speed – This drive will read at this speed. 

Audio Extraction – This drive supports audio extraction. 

Audio Accurate – This drive will accurately extract audio information. 

Read CD-RW (Multi-read) – This drive supports multi-read for CD-RW media. 

Method 2 (Multi-read) – This drive supports multi-read for the CD-ROM XA format. 
Read UPC & ISRC – This drive supports the reading of UPC and ISRC code information from the media. 
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Audio Extraction Tab 
 

The Audio Extraction tab displays/sets the audio extraction speed for the selected drive. 

Default – Use the factory default extraction speed for this drive. 

Best Quality – Use the speed that extracts audio data the most accurately. 
Fastest Speed – Use the fastest speed supported by this drive for audio extraction regardless of quality. 
 
CD and Video Properties 
 
File System Tab 
 

Media Maker gives you the following options for the File Name: 

• ISO 9660 Level 1 compliant MS-DOS names (8+3 restricted character set) 

• MS-DOS file names (8+3) 

• Joliet MS-DOS (8+3) and Windows 95, up to 64 characters 

• Romeo, Windows 95 Long filenames up to 128 characters. 

• UDF 1.5, filenames up to 255 bytes. 

ISO 9660 File Name Restrictions 
Since a CD-ROM disc was designed to be read across various platforms, such as PC, Mac and UNIX, the ISO 
9660 standard is very restrictive on file and folder names. The allowable characters for file and folder names are 
A-Z, 0-9 and _. ISO 9660 also restricts the subdirectory name and the depth of subdirectories to eight levels 
deep. 

MS-DOS File Names 
All MS-DOS file names are valid under this option. If the Disc is for DOS or Windows 3.1x, then this option is 
recommended.  

Joliet File Name Restrictions 
This file system is designed for use with Windows 95. It allows long file names. However, it still conforms to 
MS-DOS restrictions for short file names. If a CD/DVD is created using this file system, the disc can be read 
back only under Windows 95 and/or Windows NT 4.0. 

Romeo  
Romeo is defined as Windows 95 long file names only, up to 128 characters. It is supported by all Media Maker 
software, Version 3.0 and above. If a CD/DVD is created using this file system, the disc can be read back only 
under Windows 95 and/or Windows NT 4.0. 

Universal Disk Format (UDF) 
Universal Disk Format (UDF) is a CD-ROM and DVD file system standard developed to ensure consistency 
among data written to various optical media, by facilitating both data interchange and the implementation of the 
ISO/IEC 13346 standard. UDF is required for DVD-ROMs, and is used by DVD to contain MPEG audio/video 
streams. Originally developed as a replacement for the ISO 9660 file system, UDF is used by CD-RW in a 
process called packet writing that makes CD writing more efficient in terms of the time and disk space required. 
File CD packet-writing program offers both ISO 9660 and UDF support for CD-RW, DVD-RW, DVD+RW and 
DVD-RAM media. 

UDF supports a maximum volume size of up to 128 terabytes. The maximum file size is equal to the size of the 
volume containing that file. UDF allows up to 255 bytes for a file name. 
 
Volume Tab 
 

The ISO 9660 Standard allows you to describe certain information about the CD/DVD/Blu-ray. Such information 
is called the Volume Description, and will be recorded on the disc. The following briefly explain the fields in the 
Volume Description. 

Volume Name 
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You can specify an identification of the volume in this field. It allows up to 32 alphanumeric characters, which 
include 0-9 and A-Z. This field is recommended. 

Volume Set Name 
If the disc you are preparing is part of a set of discs, every disc in the set may have the same name recorded in 
this field. It allows up to 32 d-characters. This field is optional. 

System Name 
It refers that the operating system under which the application will run. It allows up to 32 a-characters. This 
field is optional. 

Publisher Name 
You can identify the publisher of the disc. It allows up to 128 a-characters. This field is optional. 

Data Prepare Name 
You can specify an identification of the person or other entity, which controls the preparation of the data to be 
recorded on the volume. It allows up to 128 a-characters. This field is optional. 

 
Date & Time Tab 
 

Specify the below Dates and Times of this volume. 

Creation 
You can specify the date and the time of the day at which the information in the volume was created. 

Modification 
You can specify the date and the time of the day at which the information in the volume was last modified. 

Expiration 
You can specify the date and the time of the day at which the information in the volume may be regarded as 
obsolete.  

Effective 
You can specify the date and the time of the day at which the information in the volume may be used. 

 
Data Format Tab 
 

You should set the Data Format of your CD-ROM disc to either CD-ROM Mode 1 (CD-ROM) or CD-ROM Mode 
2 (CD-ROM XA) or select DVD-ROM to create a Data DVD. You can select the data format from the Data CD 
Properties tabs or directly from the Data CD Layout. 

Note: 
Ñ  This option is preselected for Data DVD layouts and set to CD-ROM for a Data CD layout. You cannot 

select the DVD-ROM option from a Data CD layout.  

 
Album Tab 
 
• Album Identification - This is a text identifier for this album. 

• Number of Volumes in Album - Specify the number of CD volumes that make up this album. 

• Sequence Number of the Volume - Specify the sequence number of this volume for this album. 

• Viewing Restrictions - Specify the viewing restriction for this volume. 

 
Options 
 
General Tab 
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The General tab contains allows you to control the Program Cache Buffer,  Log File and Network and 
Removable Disk Support features of Media Maker. 

Directory for Program Cache Buffer 
The Program Cache Buffer contains temporary files that are used to make read and write operations that 
occur during a recording session smooth and reliable. You should specify a program cache buffer directory 
with enough space to hold future temporary files. If the program cache buffer has enough available space to 
hold all the temporary files created by Media Maker, the recorded data will be written on a single data track 
on the disc. Otherwise, Media Maker will split the data into multiple tracks.  

Use System TEMP Directory 
Check this box if you want Media Maker to use the same directory that is used by your Windows operating 
system to hold temporary files. 

Log File 
Media Maker will create a log file that allows you to trace and diagnose problems that can occur during 
recording. Media Maker will report all errors that have occurred in recording to this log file. You can specify 
the location and name for the log file.  

Report to log file 
Check the "Report to log file" box and enter a file name and path for the log file to allow Media Maker to save 
error information in the specified log file. 

Image Editor 
Media Maker allows you to use your favorite image editor when editing VCD and SVCD menus and slide 
images. You can either use the default editor as defined in Windows or provide the path to the image editor 
you wish to use.  

Use Default Editor 
Check the "Use Default Editor" box to use the Windows default graphics editor or enter a file name and path 
for the image editor you wish to use for VCD/SVCD image editing. 

Network and Removable Disk Support 
Check the "Copy files to the Program Cache Buffer Directory, then write them to CD Recorder" option to allow Media 
Maker to copy any source files residing on a network drive or removable media into the program cache buffer directory 
before writing to a disc. 
 
Preference Tab 
 

The Preference tab allows you select various user preferences. 

Measure source read speed. 
Check this box to allow Media Maker to automatically measure the read speed of the source data for this CD 
or layout. When checked, you can specify the amount of the source data to use for speed calculations. 
(Default – 25%)  

Try lower speed in Test mode.. 
Check this box to allow Media Maker to automatically reduce the writing speed when an error is encountered 
during the testing process. The test is re-run at the new writing speed.  

Eject disc after writing. 
Check this box to allow Media Maker to automatically eject the new disc after the writing has completed. 

Verify recorded data after write. 
Check this box to allow Media Maker to automatically verify data recorded on the CD with the source data 
files.  

Burn Disc on the fly. (Audio CD Only!) 
This option determines if converted or balanced audio files are saved as temporary files on your hard disk or 
written directly to CD. When checked, audio files are preprocessed and then written to disc before moving to 
the next track in the layout. This is the default setting for this option. 
When unchecked, the result of any audio preprocessing is saved as temporary files on the hard drive. After 
all the files have been processed, the temp files are written to CD and then deleted. This option will take 
more time but may be helpful on slower systems or older CD burners. 
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Notes: 
Ñ Audio preprocessing is required for all MP3 and WMA files in the Audio CD layout and/or Volume 

Balancing is enabled from the Write CD dialog. 
Ñ This option applies to burning an Audio CD only. 

Volume Balancing. (Audio CD Only!) 
Check this box to enable Media Maker’s Volume Balancing during the burning of Audio CDs by default. The 
Volume Balancing setting appears in the Write CD dialog when recording an Audio CD. 

 
Audio Tab 
 

The Audio Tab allows you to customize your audio CD. 

Burn disc on the fly (Audio CD only) 
This feature allows you to burn directly form one disc to another without first copying the data to the hard drive.   

Volume Balancing 
This allows you to customize the volume balancing.  You can set the threshold for both the lower and upper 
levels of your music.  For example the first line, if the song is less than 90% of a standard signal, it will boost 
the signal to 90%.  On the second line if the signal is greater that 98% of a standard signal, it will reduce the 
signal to 98%. 

Crossfade 
Crossfade allows you to fade out one song while simultaneously fading in the next song when burning an audio 
CD.  You can set the overlap from 1 to 10 seconds. 

MP3/WMA Disc 
      MP3 disc or WMA disc sets the default bit rate that the program will use to encode a MP3 or  
      WMA CD.  Settings are from 64 KB/sec to 320 KB/sec. 
 
Data Tab 
 

The Data Tab gives you several options in copying a data. 

Ignore Medium Read Errors 
 

This feature allows you to copy a disc that has read may have read errors on it.   The program will skip over the 
areas that are unreadable. 

 

Buffer Underrun Error Protection 
This allows you to turn on or off buffer under run protection on the writer. You may prefer to turn this off to 
guarantee a clean copy prior to replicating. 

Empty Folder in Layout 
This feature enables you to include empty folders in a layout during drag & drop.   

Cache Small Size Files 
      This feature is used to prevent buffer underrun issues. Caching small files that take time to   
      access & burn allows for a faster transfer rate thus less of a chance for the writer’s buffer to  
      empty prematurely.   
 
 
Technical Support 
 
Media Maker DVD Support 
 

Starting with this version of Media Maker, you can copy or create DVD-ROM discs. It may be possible to copy 
other types of non-copy-protected DVD discs. DVD operations within Media Maker are very similar to CD based 
functions with the obvious exception that the target media is a DVD disc of one of the supported formats. Simply 
select your supported DVD burner just as you would a CD burner in the CD Copy or Data DVD functions. Use 
the CD Copy function to copy your data DVDs or the Data DVD function to create a DVD ROM.  
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Beginning with this release, most of Media Maker’s tools and utilities now work on supported DVD drives. 
Generally speaking, all operations are very similar to their CD based counterparts. Any significant difference will 
be noted in the appropriate section of the Utilities Guide. 

 
 

 
Installing Media Maker 

To install Media Maker you will need approximately 35 MB of free hard disk space. An automated SETUP 
program is provided to guide you through the installation. The default target directory (the directory where Media 
Maker resides) is "C:\Program Files\NewTech Infosystems\NTI CD-Maker". The setup program will walk you 
through the installation process. 

Ä To install Media Maker: 

1.  Close all programs, including virus-protection applications, and return to the desktop. 
2.  Insert the Media Maker CD into the appropriate drive. When the drive starts up, the Media Maker 

installation screen will appear. 

Note: 
Ñ If the Media Maker installation screen does not appear, click Start and choose Run. Type 

D:\Install.exe in the Open: field, where D represents the letter of the drive in which the CD has 
been inserted. (If the drive is represented by a different letter, use that letter when typing the 
information in the Open: field.) 

3.  Click Install Media Maker to begin the installation. 

4.  At the Welcome screen, read the information and then click "Next." 

5.  Read the License Agreement and click "Yes" to accept the terms and to continue, or No to cancel 
the installation. 

6.  In the User Information window, enter your name and company (optional), and then click "Next." 

7.  In the Choose Destination Location window, read the information and click "Next" to continue. (If 
desired, click Browse to install Media Maker to a folder different from the Destination Folder that is 
shown.) 

8.  In the Select Program Folder window, read the information that is presented and click "Next." (If 
desired, a different folder can be used or created.) 

9.  Media Maker will now be installed. 

10. You’ll be asked to restart your computer. Select either option to continue and click Finish. (The 
recommended choice is "Yes, I want to restart my computer now.") 

11. After the computer restarts, re-launch any virus-protection programs that were closed before the 
program was installed. Launch Media Maker from the Desktop or the Start menu. 

Notes: 
Ñ  For Windows® 2000 and Windows® XP, you must log in as a user with Administrator Rights to 

install Media Maker. 
Ñ  For Windows® 2000 and Windows® XP, you must restart your computer after installing Media 

Maker. 

Warning! 

The AVI to MPEG-1 encoder requires that Microsoft’s DirectX, V8.0 or above, be installed on your computer. 
The setup program will test for the existence of the proper version of DirectX and warn you if it is not available. 
You will be offered the opportunity to download and install it should you choose to do so.  

The AVI to MPEG-1 encoder will have limited support for different AVI file formats until you install DirectX on 
your machine. You will not need to reinstall Media Maker should you decide to install DirectX later. We highly 
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recommend that you visit Microsoft’s DirectX web site (http://www.microsoft.com/windows/directx) should 
you have any questions regarding DirectX or its installation. 

Note: 
Ñ  Windows 98/ME and 2000 users should install the DirectX Version 8.1 runtime package. 
 

 
 

 
System Requirements 
 

Please check the following system requirements before installing Media Maker. 

Hardware Requirements 
• IBM PC or compatibles Pentium 266 or higher. 
• Minimum 64 MB Main Memory (128 MB Recommended). 
• 35 MB of available disk space, (90 MB required if Microsoft’s DirectX is required to be installed – See the 

notes below for additional information.) 
• Supported CD or DVD recorders. We are continuously adding support for new CD/DVD recorders. Please 

visit our web site at www.ntius.com for the latest list of supported CD/DVD recorders. 

It is important that your system meet the above requirements. If you have questions, please contact NTI for 
further information. 

Software Requirements 
• Microsoft Windows 2000 or XP, Vista. 

Optional 
• AVI to MPEG-1 Encoder Microsoft DirectX Version 8.0 or above. 

Notes: 

Ñ Certain new features like the AVI to MPEG-1 Encoder require the additional installation of specific Microsoft 
Multimedia components like DirectX. In some cases, these components are not available for certain versions 
of the Windows® operating system. In these situations, the specific feature may be disabled or only offer 
limited functionality. We will include these components on your Media Maker installation CD or you may be 
required to download these components from the appropriate Microsoft download site should you wish to use 
the corresponding feature. We strongly advise you to visit these download sites and determine if these 
components are suitable for your system. 

Ñ The installation of additional components like Microsoft’s DirectX may place additional requirements on your 
hardware and installed software. Please consult the support site for these components before installing a 
component to make sure that your system meets these requirements. In some cases, like DirectX V8, the 
components cannot be uninstalled without a complete reinstallation of the Windows® operating system! 

 
 

 
Web Resources 
 

Company or Product News and Information 
Find out the latest about NTI what we are doing at www.ntius.com/corporate/inthenews.htm or any of our 
world-class products at www.ntius.com/products/index.htm.  

Frequently Asked Questions (FAQs) 
You can browse the latest information and commonly asked questions about Media Maker from our web site at 
www.ntius.com/faq.htm.  

Updating your Media Maker Software 
Visit our web site at www.ntius.com/download/index.cfm for the latest updates for all NTI products! 

Updating the Drive Support Database 

http://www.microsoft.com/windows/directx
http://www.ntius.com
http://www.ntius.com/corporate/inthenews.htm
http://www.ntius.com/products/index.htm
http://www.ntius.com/faq.htm
http://www.ntius.com/download/index.cfm
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We frequently add support to new drives to our drive support database. You can use our Live Update feature to 
download and automatically install the latest drive support database on your system. Click the Live Update 
button on the toolbar to download the latest database from our servers.  

Notes: 
Ñ You must be online to use the Live Update feature. 
Ñ Live Update may not be available on all versions of the Media Maker products. 

Contacting Technical Support 
Help and information on the latest upgrades as well as a Technical Forum on Frequently Asked Questions 
(FAQs) can be found on our web site (www.NTIus.com/support). 

 
 

Basic Terminology 
 

a-character A characters are capital A to Z, digits 0 to 9, and also the following symbols: ! " % & ‘ ( ) 
* + , - . / : ; < = > ? _ 

ASPI ASPI stands for Advanced SCSI Programming Interface. This defines a set of software 
commands for applications to use when communicating with SCSI host adapters. 

Audio CD Audio CD is a basic compact disc format, also known as CD-DA (Compact Disc Digital 
Audio) which was the first CD standard. Audio CD uses PCM (Pulse Code Modulated 
audio), 44.1 kHz sampling, 16-bit and stereo format. 

Audio Track One song occupies one track, called an Audio Track on an Audio CD disc. You can 
record up to 99 songs within one session on the disc.  

Block A group of 2352 bytes as defined by the Yellow Book standard.  

CD Extra CD Extra, also known as CD Plus or Enhanced CD, includes two sessions with the first 
session containing up to 98 audio tracks and the second session containing a data 
track written in the CD-ROM XA format. 

CD-DA A CD-DA (Audio CD) disc contains tracks with Audio only. This type of disc is defined 
by the Red Book format standard. 

CD-ROM A CD-ROM disc contains only data. This type of disc is defined by the Yellow Book. 
Format standard. 

Compact Disc CD stands for Compact Disc, which is a general term for all formats of CD media. CD 
formats available on the market now include Audio CD, CD-ROM, CD-ROM XA, Video 
CD, Enhanced CD or CD Extra and CD-I. 

d-characters d characters include capital A to Z, digits 0 to 9, and the underscore symbol _. 

Disc-At-Once With Disc-At-Once writing mode, the CD-Recorder laser will not stop until the entire 
disc has finished recording. The disc is closed, and there are no link blocks between 
any two tracks. 

Hybrid Disc Typically, a hybrid disc refers to a disc containing both DOS/Windows and Macintosh 
software in separate volumes. 

Incremental 
Multisession 

Using incremental multisession to record will link existing sessions with a new session 
being written to the disc. Data from a previous session is accessible since each session 
has links to the data written in the previous session. 

Independent 
Multisession 

Using independent multisession to record will organize multiple sessions as completely 
separate volumes, each with its own directory of information. In most cases, you will 

http://www.NTIus.com/support
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need a utility such as Session Explorer to view data from a previously recorded session 
on the disc. 

ISO 9660 ISO 9660 is an internationally accepted logical-level standard for CD media. The 
standard allows different computers with different operating systems to access the 
same data format. 

Joliet Joliet is a file system created by Microsoft. It is based on the ISO9660 level 3 standard. 
A CD created under the Joliet file system can only be read back under Windows 95 and 
Windows NT 4.0 or later. The number of characters allowed in a long file name is up to 
64, and the number of characters allowed in a long directory is up to 64 characters. 
However, the sum of the long file name length and its full path length cannot exceed 
120. 

Lead-In Area The lead-in area is a reserved space on a CD that contains some information about the 
disc, such as the table of contents (TOC). The lead-in area is closed when a disc is 
finalized. 

Lead-Out Area The lead-out area is the space on the CD that indicates the end of a session. It also 
indicates that there is no more data and that the session has been finalized. 

Mixed Mode CD A Mixed Mode CD contains a combination of CD-ROM tracks and CD-DA tracks. The 
first track on the disc is a CD-ROM track, and the rest are CD-DA tracks. 

MPEG-1, Layer 3 
(.mp3) File 

MPEG-1 Layer 3, or MP3 as it is more commonly known, is the portion of the MPEG-1 
specification dealing with the recording of audio information to a file. This standard has 
gained popularity on the Internet. Currently, most CD drives will not play this audio 
format directly. Media Maker will translate MP3 files, on the fly, to wave files before they 
are written to the destination disc. 

Multisession Multisession refers to a form of recording that allows data to be written over more than 
one session. The disc can be removed from the recorder in between sessions. 

NTSC NTSC is a type of television standard used chiefly in North America and Japan. Output 
your video or slideshow discs in this format if you live in a region that uses this 
standard. Otherwise, your disc may be incompatible and unplayable. 

Overburning Overburning allows you to burn a CD that contains more data than is normally possible 
on a standard CD. It is only supported on certain CD recorders and only works when 
you use the Disk-At-Once (DAO) writing method. 

Packet-Recording Packet recording allows small packets of data to be written one packet at a time. It will 
only work with data tracks. It is supported by the File CD utility. 

PAL PAL is a type of television standard used chiefly in Europe, Hong Kong, and the Middle 
East. Output your video or slideshow discs in this format if you live in a region that uses 
this standard. Otherwise, your disc may be incompatible and unplayable. 

Path Table The path table contains the addresses of the directory files so that data files can be 
accessed directly. 

Primary Volume 
Descriptor (PVD) 

The primary volume descriptor is the relationship reference information about the CD 
file system to the medium. It refers to the path table and the root directory of a disc. 

Program 
Calibration Area 
(PCA) 

The PCA is space on the disc used to calibrate the laser power. This is done via a trial 
recording. 

Program Memory The PMA contains information about the recordings on the disc. Before you close the 
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Area (PMA) current session, to keep track of all data recorded, PMA (sort of a pre-TOC) is written to 
the disc in an area that is only accessible by the CD recorder. 

Romeo Romeo is defined as Windows 95 long file names only, up to 128 characters. 

Root Directory The root directory is a special directory file. No other directory files refer to it. 

SCSI SCSI, which stands for "Small Computer System Interface", is a standard for a 
high-speed data transfer interface between computers and their peripheral devices. A 
SCSI interface usually allows up to eight different devices to be connected to a single 
controller. 

Session Session refers to data written to a CD during the span of a single recording. It consists 
of a lead-in area, a program area, and a lead-out area. 

Session-At-Once With Session-At-Once writing mode, the CD recorder’s laser does not stop until the all 
data from the current session is written to disc. Session-At-Once is related to the 
process of recording multisession discs. 

Super Video CD A Super Video CD disc contains video clips converted from MPEG-2 files. Video clips 
must conform to the MPEG-2 (ISO 13818-1, 1994) specification. 

Table of Contents 
(TOC) 

The Table of Contents (TOC) contains information about the disc and tracks. When the 
current session is closed, the TOC will be written in the lead-in area. An unfinished 
session will not have the TOC written to the disc. 

Track-At-Once With Track-At-Once writing mode, the CD recorder will record one track at a time. The 
CD-recorder’s laser stops in between every track while the hard disk prepares the 
contents of the next track. 

Universal Disk 
Format (UDF) 

Universal Disk Format: a file system for optical media developed by the Optical Storage 
Technology Association (OSTA). It was designed for read-write interoperability between 
all the major operating systems as well as compatibility between rewritable and 
write-once media. UDF supports file names up to 255 bytes long. 

Video CD A Video CD disc contains video clips converted from MPEG files. Video clips must 
conform to the MPEG for Video CD specification as defined by the White book format 
standard. 

VIDEO_TS The VIDEO_TS folder is a required folder on a DVD-Video disc that contains vital data 
about the video, audio, menus, etc. If you are creating a DVD-Video disc, you will be 
adding your DVD-Video files to this folder. If you are using DVD Fit™ to compress a 
movie and reduce its size, you will import the VIDEO_TS folder into your layout. 

Virtual CD Layout A Virtual CD Layout is an ISO-formatted directory that indicates how files will be 
arranged on your CD. The layout contains only information as to where those 
to-be-recorded files actually reside on your drives, while the actual contents of the files 
or directories are still on the original storage media. 

Wave A Wave (.wav) file is a file that stores analog sounds in a digital format easily 
understood by computers. 

Wave File A type of sound file that can store digitized analog signals supplied by the program. If 
the file’s format is not in the format of PCM, 44.1 kHz, 16-bit and stereo, you will have 
to use a Wave Editor to convert it. 

WMA The Microsoft® Windows Media™ Audio format can handle all types of audio content, 
from speech-only audio recorded with a sampling rate of 8 kilohertz (kHz) to 48 kHz 
high-quality stereo music. WMA format files require much less disk space for storage 
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than WAV or MP3 files.  
 
 


